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Version 11.0 Update Supplement
Installing the New Version of Pulsonix
It is always recommended that you back-up all libraries, designs, technology files, profile files and
report files before installing the latest version. Other than for any technical reason, this is good
working practice, although you should already have a backup of this data!
To install Pulsonix, double-click on the download executable and wait for a short time. You may have
been supplied a CD, in which case insert it and wait for it to run. The Autorun facility will start the
installation procedure. Follow the on-screen commands from the install wizard. You can install
Pulsonix 11.0 over your existing V10.5 installation. If upgrading from V10.5, you can install it
alongside the older version if you prefer. In any case, you do not need to uninstall the old version first
unless you wish to remove it from your hard drive.

Licensing
Version 11.0 requires a new license if you are a new user or upgrading from any older version of
Pulsonix earlier than V10.0or V10.5. The new license would have been supplied to you under the
terms of your maintenance contract.
For existing users upgrading from a previous version, it is recommended that you save the new
license in the same location as the current one but make a backup copy first or rename it. When
requested during installation, simply click the No Change In Licensing check box on the licensing
page of the installation wizard. The License Manager can be used to add new licenses and make
changes to network licensing after the installation has been completed.

Version 11.0 Update Notes
These Version 11.0 Update Notes are available in the Pulsonix product installation folder under
\documents. Alternatively, select the direct link within the product itself: Help menu | Online
Manuals> Pulsonix V11.0 Updates Notes. You can also find them on the Pulsonix web site.
The current and all previous Update Notes are available on the Pulsonix web site under
Documentation.

Installation
The installation has been changed so that all Pulsonix ‘documents’ (Master Libraries, Technology
files etc.) are now located under user\documents\Pulsonix11.0 rather than being placed in public
documents\PulsonixXX
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New In Version 11.0
Report Maker – List of Files
When creating a report using Report Maker, a new list command option List of Files has been added
which when the report is run, will list all the files within a chosen folder.
The destination can be edited by double clicking the command in the format script section. A folder
path can be added by browsing a folder using the browse button, or being picked up by a report
variable or by typing in a path (this benefits from relative paths, so folders within the design folder
can be selected by just typing in that folder’s name). Whilst within the List of Files indentation in
format script, another new command File Name is available which reports the name of the file that is
found.

Part Edit – Force Display of user attributes
When editing a Part in the Part Editor, the Force Attribute Displayed dialog, available from the
Edit menu, now includes two lists for you to define what attributes you want to force displayed when
adding the Part to a schematic or PCB design. If not already in the symbol, the attribute positions will
be added underneath each other in the order from the list.

3D View Settings (STEP) Change
To avoid graphical issues (dithering, also known as Z-fighting) when drawing two or more items at
the precise same location, components are added to the STEP data using a tiny Z-offset to render
them very slightly above the surface of the board. The same is true of additional design data that
might be enabled (such as Pads).
If for some reason you need this tiny offset to be removed so that items are rendered at precisely the
same Z value then two new check boxes on the Output tab of the 3D Settings dialog allow you to do
this:

The default setting for Place items check box is unchecked. On selection of this box, the next check
box becomes available. This second check box, Only when generating STEP output file, controls
whether the decision to place items directly on the board is done in the on-screen Preview or only
when writing data to a STEP file. Note that if you check this box there is a performance overhead as
the 3D data has to be regenerated before being written to the STEP file so that items are positioned as
required in the correct position on the Z axis.

Customize – Fixed Icons
The default icons for the SVG and STEP commands on the Output menu bar were incorrect and
have been updated to use the correct icon to represent the command. To view this change, you will
have to reset the toolbar in the Customise dialog in order to get the fixed icons.
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New Direct-X Graphics Engine
Pulsonix 11 now supports Direct-X graphics. From the Options dialog, Display page, there is a new
slider for Hardware Acceleration to enable the new graphics engine. For large designs, this may
take a moment to rebuild the graphics.
This slider will allow you to choose the level of hardware acceleration you wish to be applied when
rendering graphics in a design window and balance the competing needs of initial graphics generation
time, pan and zoom performance and amount of memory used.
The slider provides 5 possible settings; the first, leftmost position, indicates minimal hardware
acceleration with purely GDI drawing and is the equivalent of the old Enhanced Graphics setting
being unchecked. The Enhanced Graphics button has been removed from the dialog.
The second position is the equivalent of Enhanced Graphics being enabled and, like in 10.5,
provides anti-aliased circle drawing but no performance improvement.
Positions three to five provide new Version 11.0 settings and indicate varying degrees of hardware
acceleration utilising the graphics card GPU. The higher the position, the more improved the pan and
zoom performance will be, but at the cost of a greater initial graphics generation time and increased
memory usage. Moving the slider to the High position will utilise all the new graphics features and
use any memory available and required.
The Flicker Free Redraw option has also been moved from the Display page.

International Language and Extended Character Support
Pulsonix version 11 has been switched to use the full Unicode instruction set. This means full
international language and extended character support. This will support special characters like Ω, ≠,
≤, ≥, ±, Æ for example and also Chinese and Korean languages. Support is through all design editors,
libraries, import filters and exports such as Gerber, Netlists, Parts Lists and all 3rd party products.
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Inspector Bar (Dynamic Properties)
The new Inspector Bar acts as a dynamic Properties windows, however, it is different.
Accessed by right clicking on the Pulsonix framework and selecting Inspector off the list of bars
available, or access it from the View menu and selecting Inspector Bar.
Generally speaking, the Inspector Bar would be left either docked open or floating so that it is
accessible instantly.
With an item selected, the Inspector Bar will display Properties for that item, for example, a selected
Component in PCB:

Context Menu Options
By right clicking on the Inspector Bar, you can access additional commands:
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Change Group Order
Select Change Group Order to rearrange the ordering of the 'groups' or sets of properties displayed
in the Inspector Bar.
Use the Up and Down arrows to move the selected group up or down in the Inspector Bar list.
Groups can be shown or hidden in the Inspector Bar using the check boxes next to the group or by
using Show All/Hide All.

Explore Net
The group Explore Net enables you to see the nodes on a selected net and the nets on the component
(if the node is from a component). This functionality also works in reverse, so for a selected
component, the Inspector Bar will show all nets on that component.
Selecting a node or net from one of the lists in the group will update the other list (Net or Component
or vice-versa), allowing the connected nets and nodes to be traversed (or explored).

Single Clicking to Navigate Nets & Nodes
Single click will ‘navigate’ net and nodes, using a double click will highlight net.
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Find Options
This offers the same finder functionality as the Find Bar, with the Find Bar options being used here
as well. These options can be viewed and changed from the Inspector Bar by right-clicking anywhere
on the bar and hovering over the Find Options context menu (see below).

Changes to Document Properties Dialog
Change to Summary Page
A new item on the Summary page of the Design Properties dialog has been added. This shows you
the current full path name of the design file.

Vertical Text Alignment for Multi-line Text
There is a new switch in Design Settings, General, under All Text to set Multi-Line Text Vertical
Align. When selected, this causes all multi-line text to vertical align using the height of all the text,
not just the first line. It will change the vertical alignment of all multi-line text in your design so care
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must be taken if applying this after already having added multi-line text, especially on electrical
layers.

The two images below show the effect of this switch. To clarify where the alignment is taken from,
horizontal and vertical construction lines have been added to the text to show the movement.
The left image is before switch is activated (and as current product), the right-hand image is after:

Option for Track & Vias styles defined in SCM to be Translated to PCB
A new option in the Design Settings option under Synchronisation now allows Net Styles in PCB to
be created from the Track & Via Size Rules in the Schematic. Use the Apply Schematic Track &
Via Size Rules to Net Styles switch to enable this feature.
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This means, where you need to specifically define Track and/or Via Styles in the Schematic, they can
now be passed through into your PCB where they will be used in Net Styles. Both the Translate To
PCB and Synchronise Designs options will use this feature once the switch is set.
If Translating to PCB to create the initial design, your PCB Technology used must already have this
switch set in order to pass across the settings. If it isn’t set, then once set, use the Synchronise Design
option to update the design with these settings.
The Track & Via Size Rules in the Schematic should be defined in accordance to your requirement.
These can be generic such as all Net Names in the design, or more refined such as specifically named
nets such as DQS*. Other parameters can be selected from the drop-down list as well as Layers,
Sides and Within Areas.

Design Settings Synchronisation
Once the Apply Schematic Track & Via Size Rules to Net Styles switch has been checked in the
PCB Design Settings Synchronise dialog, you can then define the Track and Via styles in your
Schematic design.
From in the Schematic design, use the Technology dialog and DFM/DFT Rules – Track & Via
Size Limit dialog to add rules that will be passed into your PCB design.

Translate to PCB
During Translate to PCB, with this switch set in your PCB Technology file, this setting will be
initially applied to the new design and your Schematic Track & Via Size Limit Rules will be
defined in the PCB
If the Track & Via Size Limit Rules are applied to the PCB, it will add new Track styles and a new
Pad Style to the Technology. Two new Track Styles will be created based on the Min and Max Track
width defined. The Pad style created will use the Min and Max Via Dimeter to create a pad of the
Max diameter size with a drill using the Min Diameter value.
A new Via Pad style is added to the Pad Styles dialog:
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New Track styles are added to the Track Styles dialog:

Matching settings in the Net Styles dialog for the nets requiring them will also be created using the
new (or matched) Track and Via Styles.
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Options Dialog Changes
Option for Spacing Rule Grids
A new option, Spacing Rules - Enable linking of types has been added to Design Settings,
General. When this is checked, some rows and columns on the Spacing grids will disappear
(provided the spacings are the same), and the values will be linked together. This setting will be saved
with your design so it is retained.

You can show the hidden values by unchecking the appropriate options which appear under the
spacing grid.
Before linking, the Spacing grid looks like this:

With Enable linking of types checked, the Spacing grid now looks like this:
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Thread Count Definition
A new option, Thread Count has been added to Options, General. The maximum value of the slider
is automatically presented based on the number of logical processors your PC has.

If Enable Threads is checked, multiple threads will be used to perform task that utilise it, including
but not exclusive to: CAM Plot Gerber Export, Copper pour, Design Rule Checks and Filling the
Rules spreadsheet.
The Thread Count slider defines the number of threads used when performing the above tasks.

New Options page for Pan & Zoom functionality
The Pan and Zoom settings in Options, Interaction had been moved to a new page Options, Pan &
Zoom. This page has been added to declutter the Interaction page and add new functionality
(namely, Auto Pan, see below).
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New Auto-Pan feature
Auto-Pan has been added to Pulsonix. It has been added to the Options, Pan & Zoom page. This
allows you to automatically scroll (pan) your design by moving the mouse to any edge of the design
area (the target region). When the mouse gets to within 12.7mm (1/2 inch) from the edge of the
design area, Auto-Pan is activated.
The Delay and Speed can be defined for this option.
Delay is the time it takes for the Auto-Pan option to ‘react’ when the cursor is moved into the
target region.
Speed is the speed of the pan once Auto-Pan is activated. If the slider is to the left most side,
the speed will be slow, to the right side, it will be much faster.
The Reset button is used to reset the Delay and Speed sliders back to their default factory settings
(these have been predefined to be good general working settings).

Probe Synchronised Design option added to Cross-Probe
A new option, Probe Synchronised Design has been added to the Options dialog, Interaction page
under Cross Probe.
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Selecting this option enables cross probing to take into account synchronised designs which are
assigned in the Design Settings Synchronisation dialog. When selected, cross probe will check if the
nominated synchronised document exists, and if so, selects the probed component in that design. If
the synchronised file is not found or this option is disabled, then cross probing will run as usual.

Removal of Fast Locate Option
The Fast Locate option on the Options dialog and Display page has been removed (shown below as
the empty red box). This setting was used to enable and disable the enhanced picking but is no longer
required. It will always be set on now by default but unavailable for changing.

Edit Track Option for using Layer Bias
A new option has been added to Options, Edit Track called Next Layer – Use Bias
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When editing a track, you now have the option to utilise the Layer Bias defined in your Technology
Layers. This means when using the Next Layer and Previous Layer commands, it will skip layers
with a bias of Power Plane, No Tracks or Minimum Tracks.
With this option left unchecked, the Next/Previous Layer commands will use all electrical layers of
any bias.

Optimise On Clear Template Option
On the Options, Interaction dialog, Optimise On Clear has been split out from the Optimise On
Delete option to make it clearer that an optimise will be performed when you clear a template.
There is a new Optimise On Clear check box under the Templates section to enable/disable this.

Clear All Templates – Optimise now Multi-thread
Multiple threads can now be use when optimising nets after clearing all templates. This significantly
speeds up the processing time for designs with large nets.
The selection to Enable Threads for Copper Pour has been added to the Options dialog, General
page. This setting is used by all Multi-threading technology in Pulsonix.

Optimise Settings for Large Nets
To reduce the impact of large nets on how Optimise runs, there is a new Large Net setting on the
Move page of the Options dialog. This is additional to the setting that controls how optimise works
on placing components (Continuous, Never, On Drop etc.).
This new option instructs Pulsonix to skip nets that have more than the specified number of nodes
because they are ‘expensive’ to optimise. The main Optimise Nets command will still optimise all
nets regardless of complexity, this change will improve responsiveness during interactive editing for
large nets.
Note: a node is any connection point - pad, via, star point, test point, junction or copper.
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Large Net Warning on Optimise All Nets
An additional Optimising large net warning has been added when optimising all nets. The warning is
shown at the very beginning when Optimise is run. It lists all large nets that will be optimised. This
gives you the option to not optimise these large nets.

A large net is identified in Options, Move under the Large Net setting (see above).

Optimise All Nets Multi-Threading
The ability to utilise multi-threading when Optimising All Nets has been added. This change speeds
up the overall processing time of this function.
The selection to Enable Threads for use during Optimise All has been added to the Options dialog,
General page. This setting is used by all Multi-threading technology in Pulsonix.
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Net Optimise for Pad Centres within a Shape
There is a new option in Design Settings, General, called Net Optimise. This forces a connection
(and therefore it will not be properly connected) unless the centre of a pad or via is within the shape
of the other item. This prevents pads which just touch the edge of a shape from being considered
connected and thus avoid thin bridges which may or may not be connected after manufacture. This
setting is saved with the design so that it isn’t lost.

In the example below, three clear scenarios are shown where this option is enabled and Optimise has
been run; one where the pad is touching and a connection exists, the middle one where the pad is
completely enclosed and no connection is required, and the third pad where it is clear of the shape and
shows a connection.

When DRC is run, this forms part of the Net Connectivity check (which checks for unrouted
connections).
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The pad touching here is considered
a ‘thin bridge’ which may cause
manufacturing issues.

Dynamic Align of items
There is now an option to dynamically align items being moved to static items in a Schematic or PCB
design. From the Options dialog, Move page, there are options to set for refinement.
This option is compatible with; Components, Symbols, Pads, Vias and Text.

When an item is moved, with this option enabled, ‘alignment’ lines are displayed:

Screen Snap Tolerance – This is the value for the tolerance at which an item will snap to another
item during move. The tolerance will remain the same screen distance regardless of the current zoom
level. This value will be set in the current design units.
Align With
Extents - Any item will snap to another item's extents during move. Extents is the total circumference
of a shape.
Original Position - Any item will snap to its Original Position during move.
Pads - Pads, Components/Symbols and Vias will snap to another item's Pad during move.
Vias - Pads, Components/Symbols and Vias will snap to Vias during move.
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Select from popup list
Holding down the Alt key and selecting overlapping items, a context menu will list all items at that
position, allowing you to select a specific item based on its description rather than the item. This is an
alternative to selecting the first item, then pressing the <N> key to get the new selected item within
the picking tolerance.

This feature can be disabled in the Select section of the Options dialog and Select page.
Using this option within a mode
As well as using this popup a select mode within the design, you can also use it within other modes to
obtain the correct item for selection. For example, use it within the Insert Dimension or Measure
tools.

Part Editor - Dynamic Attributes for Part Description field
For a Part in the Part Editor, the Part Description field can be created using an Attribute
substitution. For example, the Part Description may be made up like this: %%Value%%
%%Tolerance%% %%Watts%%

Once the Component is added to the design and the Attribute Values are satisfied, the Part
Description field will be populated and viewed or reported using the relevant options, for example,
Report Maker, Properties, Attribute Editor etc. It is viewed as a populated state in the design and
can only be edited from within the Part Editor.
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In Properties, the Part Description gets resolved like this to show the populated values:

Save Items to Library dialog changes
On the existing Save Items to Library dialog (available for a selected component in the design or by
dropping a design onto the Library Manager), the list boxes have been changed to be check list
boxes. This allows for you to specify which items should be added to the chosen libraries.
Additional Select All and Deselect All buttons have also been added to aid the selection of all items.

Save Missing Component Items to Library
From within a design (Schematic or PCB), when using the Edit Part, Edit Footprint or Edit Symbol
in Library options, if the selected Component’s Part definition, Footprint or Symbol does not
currently exist in any library, you will have the option to use the Save Items To Library dialog to
save it to a library first and then edit it once it's been saved.

26 Pulsonix Version 11.0 Update Notes

The individual library item is displayed in the Save Items To Library dialog:

Part Wizard changes
Add Selected Footprint/Symbol
With the New Part Wizard, when clicking Next’ on the PCB Footprints or Schematic Symbols
page, if no Footprints/Gates have been added but one is selected in the Footprints/Symbols in
Library list, a message is displayed giving you the option to add the one currently selected.
The message is also displayed on the symbol page if you haven’t added enough gates, allowing you to
add the selected one.
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Pin Type cell new option to Apply to Undefined
On the Power and Ground Pins and Gate Pins Details pages, once details have been defined, you
can now right click on the Pin Type cell and use the context menu to apply that pin type to all
undefined pin types using the Apply To All Undefined option.

Vault Library Export to Specific Folder
There is an enhanced to allow a specific Vault folder to be specified as an alternative to always
exporting all library data.
Use Export From: Vault Folder to specify a particular Vault folder from which to export library
data, or leave it blank to export ALL library data contained in the Vault.
The Browse button will display a dialog to allow you to browse the Vault folders to find the
appropriate one.
Check Include Sub Folders if you wish library data to be exported from the selected folder and all of
the sub folders it contains.

The VaultExport command is available for a Pulsonix Command File.
Optional parameters allow for the override of the options specified from within Pulsonix. By running
Pulsonix from the command line with a Pulsonix Command File as a parameter, the Vault Library
Export facility can be utilised from the Windows Scheduler to create a regular reoccurring task. The
full recommended command line is shown below:
Pulsonix.exe -hidden -commandfile <path to command file>

This feature was back-fitted to 10.5

Attribute Properties – View Name and Value for Protected status
A change to the Properties dialog and Attributes page now means you can select a protected
Attribute and Value and use the View button to view it (instead of Editing it). Previously, it wasn’t
possible to view it because it was protected and not ‘editable’. The Edit button changes state between
Edit and View depending on the attribute status.
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The feature enables you to copy and paste the Attribute name or Value using standard Windows
commands from the dialog presented.

Group Names Displayed in Component Bin
Group names are now displayed in the Component Bin.
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Toggle Bin Sort Order in Component Bin
When using the Component Bin, a new option, Toggle Bin Sort Order, has been added to the
context menu. The current sort order uses Component Name, this new toggle allows you to also sort
by group name. By default, the sort order will use Component Name.
When sorting by group name, if an item is in multiple groups then its first group will be used. If
multiple items are in the same group, they will be sorted by their Component Names. All items that
are not in a group will be sorted by their Component Names and will appear after all the items in
groups.

Double-Click selection in Selection Mask Bar
When in the Selection Masks bar, you can now double-click on a mask category check box which
will deselect all currently selected categories and then only select the category on which you have
chosen.

In the above example where three different categories are selected, if say, Board is double-clicked,
only Board will be selected and all other categories deselected.
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Override Readable Orientation of Text
The Ignore Readable Orientation check box has been added to Text Properties and Attribute
Properties dialogs. Selecting this switch disables the effect of the Adjust To Readable Orientation
switch (from Design Settings – General dialog) for that specific text.

Split Net Highlights
There is a new check box on the Split Net dialog, Keep Items Highlighted. This means that when a
net is split, if a resistor component is dropped on to the net for example, then no net highlight will
take place. The net highlight is used to indicate the renamed portion of the net. This mode is off by
default and can be selected to on for use in the option if and when required.

Shape Information/Editing Bar
A new Shape Information Bar has been added to Pulsonix. This appears as a dockable window
accessible from the View menu and displays detailed information about the currently selected shape
in a grid format that also updates on the fly. It is available to use when editing PCB and Schematic
designs, symbols and technology files. The text in the grid describes the shape details that may be
edited allowing precise modifications to be made.
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Most check boxes relate to existing Properties and are self-explanatory.
The Auto button will cause the Shape Bar to automatically switch to the most appropriate mode to
display a selected shape, i.e. if a circle is selected it will be displayed in Circle mode. Polygon shapes
will be shown in the most recently used of the possible modes.
Shapes drop down list
The shape information can be displayed in various formats dependent on the current mode selected
from the dropdown list. When a different mode is selected the grid columns will reconfigure to
display the chosen format. In all modes, shape points are shown as pairs of coordinates in adjacent X
and Y columns in the grid. The various modes are described below:
Points
The shape is shown as an initial Start Point and a series of Lines or Clockwise/Anti-clockwise arcs to
given points. For arc segments, the arc centre point is shown on the next row. The points will be
shown in absolute or relative coordinates depending on the Rel setting.
Point Offsets
The shape is shown as an initial Start Point and a series of Lines or Clockwise/Anti-clockwise arcs to
given points expressed as offsets from the previous point. For arc segments the next row shows the
centre point for the arc as an offset from the previous point. Only the Start Point will be shown in
absolute or relative coordinates depending on the Rel setting.
Segments
The shape is shown as a series of segments starting from the given point with the given length and arc
angle. The end point of the segment is given by the start point of the next segment. For the final
segment of an open shape there is an additional row showing its end point. The direction of arcs is
given by the sign of the angle with a negative value indicating an anti-clockwise arc. The points will
be shown in absolute or relative coordinates depending on the Rel setting.
Segment Offsets
The shape is shown as a series of segments, similar to Segment mode, but with their start points
expressed as offsets from the previous point. Only the start point of the initial segment will be shown
in absolute or relative coordinates depending on the Rel setting.
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Circle
If the selected shape is a circle it is shown as a Centre Point and a Radius. For any other type of
shape, the display will be blank therefore this mode is best used with the Auto option enabled.
Rectangle
If the selected shape is a rectangle it is shown as a Start Point and a Size; X = width and Y = height.
For any other type of shape, the display will be blank therefore this mode is best used with the Auto
option enabled.
Note, only orthogonal rectangles are recognised by the Shape Information Bar.
Context Menu Options
When a shape is selected, you can right click on a row in the grid of the shape bar and click Find
Segment.

This feature shares the Find Bar options (Options, Find, Action On Found Item) for Highlight and
Flashing and will find the chosen segment in the design. If you have the Highlight it and Flash it
boxes checked, then the chosen segment will be found, highlighted and/or flashed.
Find a segment using the grid
Right click the mouse over the row in the grid you with to find in the design. From the context menu
select the Find Segment item. The segment will be located by altering the view to include it and then
either selecting it, highlighting it, brighten it (dim all other items) or flashing it. The find action
depends on the current Find Options. Find Segment is not available when using Circle or Rectangle
mode.
Insert a new segment into a shape
Right click the mouse over the grid at the point you wish to insert a new segment. From the context
menu select the Insert Row item. A new segment will be insert in to the shape at that point. The exact
position of the inserted segment will depend on the current Shape Bar mode; in a Segments mode, the
new segment is inserted from the centre of the existing segment to its end point. In a Points mode, the
new segment is inserted after the end of the existing segment to the centre of the next segment (if
there is one). In either case, the end point is gridded using a step size relative to the Working Grid .
Insert Row is not available when using Circle or Rectangle mode.
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Delete a segment from a shape
Right click the mouse over the grid row containing the segment you wish to delete. From the context
menu select the Delete Row item. The way the segment is removed depends on the current Shape Bar
mode; in a Segments mode, the corner at the start of the segment is removed. In a Points mode, the
corner at the end of the segment is removed. It is not possible to delete segments from a shape if
doing so would cause it to become invalid. Delete Row is not available when using Circle or
Rectangle mode.

Scale Option
The Scale feature has been updated to allow for scaling on-the-fly of Shapes, Text, Schematic Gates
and Bitmaps.
An item is selected in the design and the Scale option selected from the context menu.

When scaling text, the ability to cycle through styles of the same width is available on the context
menu using the Next Style option.
The Scale option can also be used as a ‘mode’. Select the Scale option first from the Utilities menu,
there a number of modes you can use:

You can select an item and dynamically rescale it by moving the cursor. The actual scale is shown on
the Status bar as the scale is changed.

You can manually type in a Scale or Offset as a ‘one shot’ function to rescale an item.
Scaling Text, Layer Stack Previews, Drill Tables and Inserted Reports
Scaling text and non-symbol design items works slightly different in that when you scale these, it will
run through each text style and next the next biggest one available. This is activated by selecting text
and choosing Scale from the right-hand menu.
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For example, each time the mouse is moved away from the text, the text is changed to the next size:

Change Part - Same Footprint check box
From the Change Part dialog in the filter section, you can now select the Same Footprint check box.
This will allow you to filter the Parts to only contain ones with the same footprint as the current Part.
If you are changing the Part of a Variant, then warnings will be displayed if the footprint or pin
mapping of the newly chosen Part are different to the current part.

Find Bar Changes
Multi-Select in Find Bar
When you select several items in the Find Bar list using the Ctrl key they are all selected, but now
they are kept highlighted in the list so you can see all the selections not just the current one.
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Enhanced Selection
When using the Find bar, some list entries are used by more than one item in the design, for example
Group and Style names. In this case, on selection in the Find bar, only the first item matching the
search criteria will be found.
You can now hold the Shift key down when selecting these list entries to find all items matching the
search criteria, not just the first one, for example, all items in the selected group.
Using the Ctrl and Shift keys together you can find multiple whole items, for example, multiple
Groups.
This feature was back-fitted to 10.5

Fetch Component from Find Bar
Within the Options dialog and Find page, there is a new find option is available, Finding
Components – Allow Drag to Fetch Component. This is set on by default. This allows you to drag
a component from the find bar to “Fetch” it from elsewhere in the design, or from the bin.
In a Schematic design you will only be able to fetch a component that is on the current page.

When displaying the Component category in the Find Bar, the Allow Drag to Fetch Component
option is available on the context menu.
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Dimming All Non-found Items in Colour
A check box has been added to the Options dialog and Find page to Dim items in colour. This will
allow the Find bar to dim all the non-found items in colour, rather than all in grey.
A slider has also been added to allow the user to dim by an inputted amount.

The Dim items in colour option is also available on the context menu on the Find bar, use it to toggle
this mode.
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Search for Non-Connecting Copper
You can now search for non-connecting copper in the PCB editor using the <Non Connecting
Copper> attribute filter in the Find Bar. By setting the search to Is: Exists, all Non-connecting
Copper by net name will be listed.

Close Other Pages (SCM)
A new command to Close All Pages has been added to the File menu and to the Workbook tab as a
new command by right clicking on the tab. When applied, this works on all currently open Schematic
pages except the current one.

Allow Implied Junctions Pin Override Switch (SCM)
For a selected Pin in a Schematic design, on the Pin Properties dialog, there is a new switch for
toggling Allow Implied Junctions. This enables you to set local Implied Junctions on individual pins
and overrides the main Allow Implied Junctions setting (set in Design Settings, General page).
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Copy Net Names on Sig Refs with Ctrl-Drag (SCM)
A change has been made when using Ctrl-drag (to duplicate) a Signal Reference where the symbol
has a user-defined Net Name. Using Ctrl-drag now copies the Net Name also. If you use Ctrl-drag on
a Sig Ref symbol that has a default system Net Name allocated, only the symbol will be copied.
By default, this mode will be on. If you wish to disable it, use the Options dialog and Select page and
deselect Control Drag Sig Ref to Copy Net Name under Drag options.

You can override this option locally by using Ctrl-Shift-drag. If the option is enabled then ctrl-shiftdragging will not copy the net name, and if it is not enabled control shift dragging will copy the net
name.
This feature was back-fitted to 10.5

Insert Attribute Position (SCM)
For a Component in a Schematic, there is a new Attribute Position attribute available called
<Ungated Pin Nets>. This is available for a selected Component in the design using the Insert
Attribute Position option.
When used, this will resolve to a list of Pin = Net for all nets assigned to ungated pins, thus allowing
you to easily display the connectivity on the component that would otherwise be ‘hidden’ because the
pins are not present on the symbol.

Previously, the only way to see ungated pin nets on the drawing was to insert a user report such as the
provided Ungated Pins Report that makes a table of Parts, Components and their ungated pin nets
that you can place on the drawing. With this new attribute value, you can display a simple list of those
pins and nets right alongside the Component itself.
Inserted into the design it looks like this:
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New Colour Category for Bus & Connections (SCM)
A new colour category for Bus & Connections has been added to Schematic Colours dialog. This
brings together colours from Others and Shapes.

No Connect Pin Highlight Colour (SCM)
There is a new setting in the Colours dialog and Highlights page for No Connect Pin.
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When enabled from the Pin Properties dialog, this causes the name of the pin type to be substituted
into the Net Name attribute for No Connect Pins. Once enabled, a Net Name attribute position will be
added to a pin if you make it No Connect and it will be drawn in the highlight colour.
This will also work on Component Pins and Block Ports.

Displayed like this:

No Connect Pin context menu option to Show No Connect
Within the Colours dialog, Highlights and No Connect Pin enabled, selection of a pin with a type of
No Connect and right clicking, shows you the option Show No Connect. This replaces Show Net
Name and will add a Net Attribute Position with the text No Connect value.
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Display Pin Type Attribute (SCM)
You can now display (in the design) the Pin Type on a pin using the <Pin Type> attribute. In either
the symbol within the Symbol Editor or on the Component Pin in the design, use Attribute Position
for a selected pin and choose <Pin Type>.
In the symbol, it will show as <Undefined> and in the design will be populated with the Pin Type if
defined (locally in the design or in the Part definition).

Changes to Insert Signal Reference dialog (SCM)
The Insert Signal Reference dialog has been changed to now include all the Sig Ref symbol types
available. This means the Insert Bus Reference and Insert Page Link options are no longer on the
Insert menu. They can now both be added using the Insert Signal Reference option, (the new Insert
Net Label feature will also be included in this dialog, see below).

On use, you can either scroll through all the names and decide which symbol you require or you can
use the Type: drop down list to refine the selection. For Type, you now have All, Bus Reference, Net
Label, Page Link and Signal Reference available.

New Signal Reference Type - Net labels (SCM)
New Doc Symbol Type – Net Label
A new symbol type called Net Labels has been added. These are used to 'hang' on a net to explicitly
show the net name on your Schematic design. Because it uses a special doc symbol, it means you can
customise how it looks and where it is attached to. The symbol's net name is dynamic and will update
as the name changes. On creation, the symbol will contain a pin and an attached callout with the net
name attribute stored in the callout.
These can be created using the New Doc Symbol option from the File menu and New option by
choosing the Net Label option or from the Library Manager and SCM Doc Sym page.
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Once you’ve created the new symbol, use

Changing Existing Doc Symbols (Signal References) to Net Labels
To change an existing doc symbol to a Net Label, edit the Symbol in library and use the Symbol
Properties dialog from the Edit menu and change the Type to Net Label.

This can also be done when using Save To documentation Symbol Library. The symbol will then
need to be reloaded into the design.
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If you don’t do this, the Next/Previous Symbol option (see below) will still operate but will work on
the current type. It may mean that it will spin through types that aren’t relevant. Changing and
reloading will make the Next/Previous symbol option more relevant and focused.
New Insert Net Label command
There is also a new Insert Net Label command available if required that can be added to your toolbar
using the Customise dialog.

Inserting Net Labels into your design
You can add net labels by using the Insert Sig Ref and selecting the Type as All or Net Label. Net
Labels are used to ‘hang’ on a net to explicitly show the net name. Because it uses a special doc
symbol, it means you can customise how it looks and where it is attached to. The symbol’s net name
is dynamic and will update as the name changes.
The Type drop down box on the Insert Sig Ref dialog enables the Sig Ref choice to be filtered. This
will filter on All, Bus Reference, Net label, Page Link, and Signal Reference Doc Symbols.

In all other Insert Doc Symbol dialogs, the Type drop down box will be read only and will display
the type of the symbol you are inserting.
Once on the end of your cursor, drop the Net Label onto the net requiring it.
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Insert Connection - Start/End on a Net Label
When inserting or editing a Schematic Connection, you can choose to Start/End Connection On a
Net Label using the option from the context menu.

Next/Previous Doc Symbol Command
When a single Signal Reference, Net Label, Bus Ref or Page Link symbol is selected in the design,
you can now select Next Symbol and Previous Symbol options from the context menu.

This will replace the currently used symbol with the next/previous symbol from your SCM Doc Sym
Library. This will use Symbols of the same type.
This means it will choose the next Net Label or next Signal Ref Symbol for example as relevant to the
currently selected symbol type.
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Mounting Hole Symbols in Schematic (SCM)
You can now add a Doc Symbol to a Schematic design to represent a Mounting Hole in the PCB.
When creating a New SCM Doc Symbol, the choice now includes Mounting Hole. When saving the
new Doc Symbol, you can choose Mounting Hole as the Type:
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Adding The Mounting Hole Doc Symbol
A new option on the Insert menu, Mounting Hole, enables this new type of doc symbol to be added
to a Schematic design. Choose the Mounting Hole required from a list of items from your Doc
Symbol library.

These symbols can be added to an existing net to enable their net connectivity in your PCB design.
Mounting Hole Doc Symbols In The Design
Once added to your Schematic design, the Mounting Hole Doc Symbol can be changed using
Properties.

Following successful Translation to PCB, Mounting Holes are added to the PCB using the
Mounting Holes setting in the Design Settings, Defaults page. This setting will select the layer for
the Mounting Hole and Pad Style used, the same as if using the Insert Mounting Hole option.
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Copy Net Names for Signal References (SCM)
Ctrl-drag, used to duplicate a Signal Reference Symbol, now also copies its Net Name.
This is particularly useful for a Net Label Sig Ref for example, where a Net Name should also be
duplicated. It will only duplicate Net Labels where a user defined Net Name has been used, it will not
duplicate auto-generated Net Names.
To disable this feature for use on another net, simply copy the Sig Ref symbol but press Ctrl-Shiftdrag instead.

This feature was back-fitted to 10.5

Text Formatting option for Spice Netlist Export (SCM)
When exporting a Spice netlist through the Simulation menu, on the Set Spice Netlist Type page,
you can now choose how the Spice netlist handles international characters using the ASCII, Unicode
and UTF8 settings. A setting can be chosen using the selections on the dropdown list. By default, this
will be set to ASCII.

Weld multiple Components to a Bus segment (SCM)
The auto weld feature to drag the pins of a Component over a Bus segment has been extended to
allow dragging of multiple Components over a Bus segment (like a set of resistors for example). This
can be Components of a like type or dissimilar type.

With weld markers shown >>
This feature was back-fitted to 10.5.
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New ERC Check - Nets Only On Ungated Pins (SCM)
A new option in Electrical Rules Check to allow you to find which nets are only on Ungated Pins.
If you have Components in your Schematic design that use Ungated Pins and these are not connected
outside of this device, this check will identify that single pin nets have not been created when
translating to the PCB.

First Free Component Name in Properties (SCM)
In Schematics, on the Component Properties dialog, there is now a button which will give you the
first free component name that does not yet exist in the design.

New PCB Wizard
A new wizard is available on the New dialog and Wizards for creating a new PCB design.
The New PCB Wizard allows you to specify the Technology file you want to use (or use the default
technology) and the default units.

Then you can either use the Layers from the chosen Technology, or define your own using the type
and bias required.
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Finally, you can either define a board size, use a Profile, or copy a board from another file. Your
selections will then create the appropriate PCB design once the design name is chosen on the Finish
page.
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Changes to Database Check and Update Options
If you have the Pulsonix Database Connection (PDC) option, from the Tools menu and
Check/Update Against Database option in the Schematic editor, you can now choose to update the
selected Components on the Current Page or All Pages, (All Pages means components selected on
different pages).

Technology Changes
Pad Styles – new Usage Types
Pad Style usage on the Pad Styles dialog in the Technology has been expanded to include use for
Through Mounting Holes and Surface Mounting Holes.

When adding Mounting Holes, if you swap from though-hole to surface mount and then change the
Pad Style, if you have a long list of styles, this will aid distinguishing and refining the list to only use
pads that are approved for this function.
This functionality was back-fitted to version 10.5.
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Drill Removes Pad Warning now shows Pad Style
When adding or editing Pad Styles, when you press the OK or Apply buttons on the dialog to exit it,
if there are a number of pads that have a drill size larger than the pad size, the warning dialog
presented will now also show you the Pad Style name so it can be easily identified. Previously, the
Pad Style wasn’t shown.

Units shown in Technology
You can now temporarily switch the units on the Technology dialog using the Units button at the
bottom of the page. The button will display the units currently being used on this page of the
Technology. When toggled, a small asterisk * will appear to show you that the units currently being
used are different to the design units. The setting of this button does not affect the design units.

Additional Cell Status Indicators
The small triangle on the top left of the first cell in each row now indicates more states, Orange and
Grey states have been added;
Red is an Error (as before). For example, on a Retangle Pad Shape where the Width defined
exceeds the Length.

Blue is a Warning (as before). For example, a Drill Hole larger than the pad on a Pad Style.

Orange indicates a new row
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Grey is a modified row. This has been extended to all pages that have a Used or Enabled first
column, e.g. Styles, Layers etc.

For Rules pages only, the Green triangle in the top right corner of the cell indicates the rule
contains a note (as before).

Updated Design Settings Pages
The Design Settings Defaults pages have been moved from a separate property sheet (accessed from
General/Defaults in Technology) to a sub-category of Defaults off the Design Settings tab in the
Technology.
The new switch Units button that has been added to the Technology dialog also works for all
compatible Defaults pages, for example Branch Points.
The Edit Default” button that appeared on the General/Defaults page has been removed as it is no
longer required and the page has been renamed to General.
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Changes to Grids dialog
There are three main changes to Grids;
·

Grid presentation in a table

·

Removal of in-built grids

·

New Tools Grid page

Grid Presentation
Design Grids are now presented in a ‘grid’ and operate in much the same way as other gridded pages
in the Technology.

No In-built Grids
There are now no in-built grids, and you can rename and delete any unused grids.
Previously, built-in grids were shown in brackets, like <Working> for example. When your designs or
Technology files are read into V11.0, the grid names will be preserved but you can now rename them
or delete them (if unused). Like any table that has a value that is used shown with a Y next to its
name, the name cannot be removed until unused. You can also remove all grid names from the list
although this isn’t advised. If all grids are removed, you will only be able to work gridless.
If you have allocated shortcut keys for existing commands Next Grid and Next User Grid, these
will spin through all grids now. Any grids not required can be removed, for example, existing
‘system’ grids (in brackets such as <Working>).
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New Tools Grid page
Under Technology and Grids, there is a new Tools Grid page. This is used to define the ‘default’
grids used by non-interactive items.

When the Use Different Grid for Item Types is selected, these grid settings are used:
Component: auto place, arrange
Test Point: auto place, auto insert TP, testability report, auto routers
Track: auto routers
Via: apply vias, auto routers
PCB Panel and Text, these are currently not used.
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Group Name available in Component Place Rules
You can now use <Group Name> as the rule attribute in the Component Place rules dialog in the
Technology. This name is available on the Attribute drop down list.

Component Placement Rule - Default Mirror State
There are new ways to define the default mirror state when adding a Component.
Footprint Editor – Mirror Status
In the Footprint Editor, using the Edit menu and Symbol Properties, you can define a footprint to
be added Mirrored or Not Mirrored. This is used when adding a Component to a PCB design.
The normal state is Mirror Undefined - its mirror state is determined elsewhere. Not Mirrored
means the footprint will not be mirrored, Mirrored means it will be mirrored.

You can define a footprint as Defined Mirrored, which means it is designed as it would appear when
mirrored. See section below under Define Mirrored Footprints.
Technology Component Placement Rule
You can create a Component Placement Rule to default the side (i.e. the mirror state) based on
Component Attributes.

By defining a rule based on a specific Side and selecting the Default Side check box, you can force
the placement side when adding Components to your PCB design.
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Pad Styles – New Naming Rule for Non-round Holes
You can now add drill length for non-round holes. A new Field of Drill Length is available for
selection. A Template value of <dlen> is used when inserted.

Micro-Via to Buried Via Stagger Spacing
Within the Technology Spacing rules and Drill tab of design level spacings, the Stagger option to
has been renamed to Stagger to Micro-via.
A new spacing rule has been added to the Drill tab named Stagger to Buried Via. This allows for
checking spacings between micro vias and buried vias on adjacent layer spans.
Each of these rules will be the minimum centre to centre distance between micro-vias on adjacent
layer spans or the minimum centre to centre distance between a micro-via and a buried via on
adjacent layer spans respectively.

This feature was back-fitted to 10.5

User Defined Pad Shape Improvements
Define Pad Shape - Multiple Shapes Allowed
In Define Pad Shape, you can add multiple shapes for on a Non-Electrical layer. For example, to
define multiple glue spots. This can be done by adding the extra shapes and changing their layer to an
appropriate one.
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Define Pad Shape now contain Text, Dimensions and Callouts
When using the Define Pad Shape editor (when editing a pad style from a PCB Design) you can
now add Text, Dimensions and Callouts. These are in addition to being able to add Construction
Lines. Properties, Technology Styles, Defaults and Colours are available to support these
documentation items.
Saving Documentation items for reuse
In version 11, you can now save all of these items within the Pad Shape so that they can be recalled
for use on future edits. Effectively, for special Pad Shapes that have this additional information you
will create a set of Pad Shapes in your library. Previously, Construction Lines we transient and lost
when you edited the Pad Shape editor. To save these Documentation items, you must save the Pad
to a PCB Doc Symbol in a library. If you choose not to save the Pad to a Doc Symbol then the
additional information will be lost. Not saving the Pad Shape will still mean it retains any user
defined shapes as before.
When saving back to a style in the PCB design, if the Pad Shape is in a library or if the Pad Shape
contains documentation items, you are asked if you want to save to a Doc Symbol library.

Choosing Yes will display the Save To Documentation Symbol Library dialog:

This can also be accessed from the File menu using the Save To Library option.
Choosing No will exit the Pad Shape editor, save the pad shape defined but will not save any of the
additional documentation information, this will be lost.
User defined pad shapes can now be added to the Vault as well as your PCB Documentation
Symbol Library.
Saving a Pad Shape as a Doc Symbol will be saved as a new symbol type, Pad Shape. These can be
edited the same as any other Doc Symbol and accessed from the PCB Doc Symbol Library
Manager.
Load Pad Shape From Library
When editing PCB pad style, from in the Footprint Editor for example, if you wish to use a Pad
Shape that has already been saved as a Doc Symbol, then for a selected pad, you can use Load Pad
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Shape From Library from the context menu. If the pad style name is already in a library or vault you
will be asked if you want to load it when first editing the style.

Technology Layers - Reflect Layers
A new Reflect button to the Layers page in the Technology has been added. This allows you to
create the ‘other’ half of a layer structure by reflecting the current layers. For example, you can create
the top 7 layers of a 14-layer board, and using Reflect, then create the bottom 7 layers automatically.

After using Reflect:

If, in your existing layer structure, you have a substrate already defined, this will also be reflected.
Any additional unwanted and unused layers can be deleted as required.
The Reflect button will be disabled if you add or delete any layers from the grid and are yet to click
apply (this could cause issues with the layer order). The button will enable once the changes are
applied to the design.
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If you use Reflect and you have (for example) a Silkscreen Top layer and you already have a
Silkscreen Bottom layer that is used in the design, no changes will be applied to that bottom layer. If
the Silkscreen Bottom layer is not used in the design, then the layer data from Silkscreen Top will be
copied to it (for example, Silkscreen Top is reflected and that layer replaces the current Silkscreen
Bottom layer).

Thermal Rules – Rotate with Pad
Within the Thermal Rules page of the Technology dialog, there is an option to rotate the thermal
pattern to the angle of the pad (Rotate With Pad).

If a pad is at 25 degrees for example, and the first spoke angle is 0 degrees, the first spoke would
actually be a 0 degrees relative to the pad, but 25 degrees relative to the board.

This feature was back-fitted to 10.5

Thermal Rules for additional Pad Types
You can now define explicit Thermal rules for Micro-vias, Through Mounting Holes and Surface
Mounting Holes. To use this correctly, you should define the rules in the correct order required in
order for them to take precedence. For example, Micro-via before Via (as via also applies to Microvias).

60 Pulsonix Version 11.0 Update Notes

Copper Neck Width Rules (Power Dissipation)
The Copper Neck Width Rules dialog within the Technology is used to define the minimum necked
width of a piece of copper which forms a connection on a net (this is not a slither check). The
minimum necked width is the minimum width for the body of copper between two pins connected by
that copper. The rule can be checked using a Design Rule Check and the rule under Nets, Copper
Neck Width.
This rule could be used where power dissipation is important and you require a certain minimum gap
between pads to be adhered to. It would be normal to check for specific nets to be adhering to this
rule, such as power and ground.
This rule works on all poured copper but is not used for implied powerplanes (Layers defined in your
Technology with a bias of Powerplane).

Minimum Neck Width
The Minimum Neck Width is the minimum width of copper between two pads connected by the
copper. The width is the total of each piece of copper between cutouts in the path between the two
pads. This will be positive closed copper shapes and doesn’t include tracks or thermal spokes.
When the rule defines Pads, it means all pad types including, Component and free Pads, Mounting
Holes, Vias and Doc Symbol pads provided they exist on the same layer as the check.
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The illustration below highlights the ‘gaps’ that are available for power dissipation to take place.

Creepage Rules
A new page on the Technology dialog under DFM/DFT, named Creepage Rules, enables you to
define rules for Creepage.

The purpose of the check is to report where the total surface gaps could allow creepage between two
nets, either directly or through third party copper. You can also check creepage around board edges or
cutouts. You can limit this check to a specific layer or named area.
Creepage is caused by current flowing through pollutants on the surface of a board, this is typically
increased with higher voltages. The creepage check finds gaps between critical nets between which
current could flow. Third party copper can conduct current, meaning that the creepage can accumulate
in several steps or jumps between the two critical nets. As this flow is across the surface of the board,
the distance can effectively be increased by cutting a slot in the board, the creepage distance then
follows the lip of the board edge. Current can also flow around the edge of the board in the third
dimension, so changing layers. Although typically less of a problem, creepage can occur across inner
board layers. There are therefore two values for the maximum creepage distance - Outer and Inner,
which are then combined to give the final result.
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Using this Rule
It is normal to define a specific net or a few nets that are critical to your design when considering
creepage. These nets would be defined to be minimum distances from other nets in the design,
possibly all others.
To achieve this, as with all other rules, you define the critical net (Check Net) and define the net
which it is checked against (Against Nets).
Nets can be checked on a Side, Layers, Layer sets or within an Area.

Maximum Outer Distance
The maximum total distance for which creepage would cause a problem on the outer surfaces of the
board. This includes the distance around a board edge. This distance around the board edge can
include changing layers, as well as around the lip of the edge. A value of 0 means that no creepage
distance is checked on an outer layer.
Maximum Inner Distance
The maximum total distance creepage would cause a problem on inner layers of the board. This value
is typically less than the Maximum Outer Distance. This does not include any layer changes as these
can only be done on the outer edges of the board. A value of 0 means that no creepage distance is
checked on an inner layer.
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Flow Around Edge
Check this box to allow layer changes by flowing around the edge of the board in the third dimension
(the board edge includes board cutouts). This does not prevent flow around the lip of the board edge
in the layer plane.

Max Steps
The maximum number of steps between copper. One step means a single gap between the two
nominated nets. Two steps means that an intermediate piece of copper is traversed.

Combining Inner and Outer Distances
Each step will contribute to the total inner or outer distance. The inner and outer distances are
combined in proportion to their respective maximums. If the total percentage does not exceed 100%,
then there is an error. For example: Maximum Outer Distance = 2mm, Maximum Inner Distance =
1mm; actual total outer distance = 1.5mm (75% of maximum), actual total inner distance = 0.3mm
(30% of total); total percentage = 105% so there is no error.

Design Settings – new Synchronise Design options
In the PCB Technology file under Design Settings and Synchronise, there is a new option switch in
the list named Apply Net Colours. This will cause the Own Colour assignments for Net Names,
Differential Pairs, Signal Paths and Sub Nets in the PCB to be synchronised with those defined in
the Schematic. This may be useful for quickly identifying these items in the two designs.
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Also, in this dialog, the Differential Pairs colour changes has been removed from strict synchronise
option when the Apply All Rules Strictly switch is use.

Import IPC-2581 Layer Stackup into Layers dialog
An option to import Layers, Layer Classes, Materials and Impedance rules from an IPC-2581
Layer Stackup file produced by 3rd party products, such as Polar Instruments has been added.
This format is now available from the Technology page and Layers, and also from the Import
Design Data option on the File menu.
Layers Technology Page
On the Layers Technology page the Import CSV… button has been replaced with Import… When
selected, you can import CSV files (as before) and new Layer Stackup (*.xml) files, (the .xml
format is used by IPC-2581). The Files of Type filter allows you to choose the type required.
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Import IPC-2581 Layer Stackup dialog
On selection of a valid IPC-2581 file you are presented with a dialog from where you can choose an
existing mapping file or create a layer mapping set.

The imported file populates the Layers dialog:
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Layers Import/Export CSV into Layers dialog
There are new options on the Layer Technology dialog that enable you to Export Layers to a CSV
file and Import Layers from a CSV file. This is intended to allow you to create layer stacks quickly
or from an external resource.
The export column headings for a layer are Name, Class, Type, Side, Top Facing, Bias, Net,
Material, Thickness, Embedding and Associated With.
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Import dialog
Similar to the Export dialog with controls for defining how the CSV file is formatted, any concessions
for Row 1 and Column A and layer mappings available.

Option to use a spacing shape even when pad is suppressed
There is a new option in the Technology dialog, Spacing Rules and Design Level – Pad tab named
Use Suppressed pad spacing shape.
With this enabled, it means that even when pad is suppressed (on an inner layer for example) as
defined in your Technology, Layers, it will still use a spacing shape on a pad if one is defined. All
other pad suppression will still be adhered to though if defined.
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Load Technology - Matching Styles on Reload
Reporting on Reload
When loading a Technology file, a report will now be generated showing any styles in the design that
have been changed as a result of the load.
Matching Styles on Reload
You can now view the current style matching method on the Load Technology dialog. This will be
set to By Name Only by default but can be changed to Use Design Settings’ using the check box.
This will use the style matching method from the Design Settings dialog, General page and
Matching Styles option.

Rotated Pad Styles for ‘Long’ Pads
Long pad styles in Pulsonix are defined pointing up so the length lies along the Y axis. Some long pad
styles in your existing designs are invisibly rotated by 90 degrees, so the length lies along the X axis.
This situation normally happens when the design or library is imported from another system, or when
using the User-defined Pad Shape Editor to define a rectangle or oval pad with that orientation.
This has caused confusion as the rotation cannot be seen and there is no easy way to remove it.
A change has been made to show “Rotated” next to the pad width and length if it is rotated. Also, if
the style is changed to a point shape (like round, square or octagon) the rotation is removed. This way
a customer can change a rotated rectangle to a round and back to a rectangle to remove its hidden
rotation.

Pad Properties Layer Override
Added a layer override check box has been added to Pad Properties when Component Pads are
selected in the design. This is useful if, for example, you locally swap a through hole pad Component
Pad for a surface mount pad but then also need this to be on a specific <Side> layer, such a Top Side.
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From an application perspective, a specific Part purchased is only available as through-hole and the
board is mounted on a metal housing. If the connections of the high-voltage components were
assembled as through-hole, this would produce a high-voltage flashover on the housing. Assembling
the component as surface mounted on the top side, the board serves as insulation.

Lock Pad Details in Footprint Editor
Within the Footprint editor, for Pad Properties, there is now a Lock Details check box. This stops
the physical details on a pad from being edited in the design.

With this box checked, the pad on the footprint in the design is locked and its properties greyed out.
The dialog is marked with Override Locked under Physical Details:
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Define Mirrored Footprints in Footprint Editor
Within the Footprint Editor, you can define a footprint as Defined Mirrored, which means it is
designed as it would appear when mirrored.

If the Designed Mirrored box is checked, the orientation of the footprint, as defined in the editor, is
the mirrored state. It is likely that you will also want to set the Mirrored state as described above.
The normal state is to leave this box unchecked.

Area Colour in PCB Doc Symbol Editor
Area colours can now be defined in the PCB Doc Symbol Editor.

Background Dimming on Mark Net
In the PCB editor, there is a new functionality that allows you to toggle the background dimming
whilst using Mark Net (Selected Net) in Latch Mode. This toggle is listed in the context menu
whilst within this mode.
When in Mark Net mode, right click and toggle Dim Design To Brighten Net mode.
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Copper Pour Multi-Threading
The option, Pour All Templates can now use multiple threads. For large or complex designs, or
designs with many templates, this significantly speeds up the processing.
The selection to Enable Threads for Copper Pour has been added to the Options dialog, General
page. This setting is used by all Multi-threading technology in Pulsonix.

Optimise after Clear All Templates Multi-threading
Multiple threads can now be used when Optimising nets after clearing all templates. The
Optimisation of nets is performed when Clear All Templates feature is run. Optimise is also
controlled by Optimise On Clear switch on the Interaction page in Options. For designs with large
nets, unchecking this option will significantly speed up the clearing of Templates.

The selection to Enable Threads for Optimise after Clear All Templates has been added to the
Options dialog, General page. This setting is used by all Multi-threading technology in Pulsonix.

Change Style DRC Checks Multi-Threading
Design Rules Checking can now use multiple threads when after changing styles of many items.
The selection to Enable Threads for Design Rules Checking has been added to the Options dialog,
General page. This setting is used by all Multi-threading technology in Pulsonix.

Change Style Performance Update
Changing a Style
Changing a Style is now classed as an After Edit DRC action. If this option is disabled in the
Options dialog, Online DRC page, then DRC will not be performed after changing style.
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Vias Attached On Different Layers
When multiple vias are selected that have different connectivity, the wording <Different> will be seen
in the Attached on layers list box, this makes opening the Via Properties dialog much faster when a
lot of vias are selected.

This feature was back-fitted to 10.5

Multi-Threaded Design Rule Checking
Design Rules Checking can now use multiple threads when doing Spacing checks.
The selection to Enable Threads for Design Rules Checking has been added to the Options dialog,
General page. This setting is used by all Multi-threading technology in Pulsonix.

New Design Rule Checks
The DRC dialogs for PCB, Footprints and Panels have been rearranged for clarity with options under
each category are now sorted in alphabetical order. The category Testpoints have been split from
Manufacturing for additional clarity.
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Same Net Via To SMD
There is a new option in DRC to check the spacing between Vias and SMD pads on the same net.

The Same Net Via To SMD Pad spacing is defined in your Technology dialog under Via rules
(Rules – DFM/DFT).

This can also be enabled in Online DRC by selecting the Check Same net Via To SMD check box
in the Options dialog and Online DRC page. When using Online DRC, the clearances will also be
displayed.

74 Pulsonix Version 11.0 Update Notes

Silkscreen Overlap
There is a new option in DRC to check for any pads that are overlapped by silkscreen items.

Time To Process shown in DRC Report
The DRC report now shows the time taken to perform the check. You’ll find this in the summary at
the bottom of the report.
Total:
7
1
223
54
4
47

Board to Component Error (B-Cm)
Board to Copper Error (B-C)
Board to Pad Error (B-P)
Board to SMD Pad Error (B-SM)
Component to Component Error (Cm-Cm)
SMD Pad to SMD Pad Error (SM-SM)

Checking took 0.657 Seconds
Number of errors found : 336

This feature was back-fitted to 10.5

Changes to Online DRC
Display Clearances for Multiple Items
You can now see clearances when moving multiple items, for example, multiple Tracks as well as
multiple Components.
The Online DRC dialog in Options has been changed to Allow Checking of Multiple Items).
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Changes to Show Design Rule Clearance
Within the Online DRC page of Options, display clearances section has been changed. Instead of
three radio buttons for On All Items, Within Distance and Within Grid Steps, On All Items is now
a check box. This allows for refining the clearances when moving a selection that has multiple
possible clearances. When checked, the clearances for the selected item will be shown, but when
another selected item comes within the defined distance or grid steps of an item it has a different
clearance with, the clearance for that item will change.
The Refine Within Distance words will toggle between this and Only Within Distance depending
on the On All Items check box selection.

Continuous Online DRC switch added to context menu
A new switch has been added to the context menu to enable Continuous Online DRC. This enables
you to suspend Continuous mode so that errors can be added (whilst using On Drop mode) without
having to use the Options dialog.

‘End Track On Via’ Clearances
Continuous DRC and Via Errors
Via Spacing clearances are now shown for Vias added using the End Track On Via option when
editing a Track. With a Via on the end of the track and Continuous DRC enabled (from the context
menu), the clearance shown will toggle to the error colour when the via is in error.
The clearances for the via when using End Track On Via will only be shown if the Allow checking
of multiple items option is enabled (it is no longer called Allow checking of multiple components).
If Continuous Online DRC is disabled, the clearances will use the error colour if either the via or the
Track breaks the Spacing Rules defined in your Technology. If Continuous Online DRC is enabled,
the Track will be ‘blocked’ from breaking any Spacing Rules, and the via will make clearances the
error colour if it is breaking any Spacing rules.
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Allow Checking of Multiple Items
Allow Checking of Multiple Items has been added to the context menu when using the End Track
On Via option. If this option is not checked, only the clearances for the Track will be seen. If it is
checked, the clearances between the Track and the item, or the via and the item will be seen;
whichever one is closest to being in violation.
If the Clearances are being displayed on all items, the clearance for the Track will be shown, and the
clearances for the via will be shown when the via is within the distance defined in the ‘Refine within
distance’ section of Options, Online DRC.

This option works for End Track On Via, End Track On Testpoint Via and End Track On
Testpoint Pad.

Dimensions Changes
Hide Arrows on a Directional Dimension
You can now hide the arrows on a Directional Orthogonal Dimension. A new check box, Directional
Type: Show Arrows, on the Defaults Dimension page, allows show or hide arrows.

When you add a new directional dimension, the arrows will be shown depending on this setting.
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Show Arrows checked

Shows Arrows unchecked

If you select a directional dimension in the design, and use Properties, the Dimension Arrows page
now includes a Show Directional Dimension Arrows check box that you can use to show or hide the
arrows for the selected dimensions.

Linear and Radial Dimensions – Show both Metric and Imperial Units
Linear and Radial dimensions can display both Metric and Imperial units for the same dimension.

Additional check boxes to Show Alternative Length Units and Show Alternative Radial Length
Units have been added to the Defaults Dimension Units page.
When selected, the alternative units text is added after the normal dimension distance text, enclosed in
the Prefix and Postfix text, for example 4141 thou (22.61 mm). Brackets and formatting can be added
using Prefix and Postfix entries.
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If you select a linear or radial dimension in the design, and use Properties, the Dimension page now
includes a Show Alternative Units check box that you can use to change the alternative units
displayed for the selected dimensions.
There is a new section to accommodate this:
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STEP 3D Changes
Minimise STEP File Size Option in STEP Output
There is a new option to Minimise STEP File Size available on the new Output page of the STEP
3D Settings. This reduces the size of the generated STEP file by omitting non-essential parametric
curve data. This is set on by default.

Improved Trihedron Axes Indicator for STEP Preview & Models
The old axis indicator ‘nodules’ have been replaced with more standard trihedron axes. This displays
arrows designating the positive direction away from the origin on that axis, with the red, green, and
blue colours matching the axes.

As well as the main 3D Preview window, the trihedron axes have also been added to 3D View
Settings, Enclosures (New and Edit buttons) and Library – STEP Models.
STEP Model Trihedron View
The model trihedron axes (in addition to the overall trihedron axes) is now also displayed in the
Footprint editor and 3D Settings Enclosures, Position STEP Model. The lines and spheres in
previous releases have been replaced with colour-coordinated arrow heads, to represent the direction
the model is pointing away from origin.
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These arrow heads are
all consistent with the
main orientation
trihedron axes at the
bottom of the preview

The main orientation
trihedron axes

Added ability to ‘Align’ STEP items
In the STEP Preview, a new Align> mode can be selected from the Tools menu. You can select any
two shapes, faces, edges or vertices (or any combination thereof) and the first selected item will
instantly snap to meet the second. This allows you to select an item in the 3D Preview and align a
sub-selection of that shape with a sub-selection of any other shape, such that they’re inline on that
axis.
Four new modes are available to select from the Align> option: Snap To, Align by X, Align by Y
and Align by Z
When any of these modes are selected, the Spacing threshold can now be declared prior to aligning on
an axis or snapping to, meaning that the two points selected will be exactly that distance apart after
the operation. A dialog is presented to choose the Snap to Spacing value. The dialog is pre-set with
the default Spacing Rule value from the PCB design.

The Snap To option is an interactive mode where the first face is selected and the item snapped to the
second selected object.
This will move the STEP model (along with the Component), into a new position chosen. This
positional change will be reflected in the PCB design with a reposition of the Component.
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The images below show the process for alignment:

Select the first vertices

Select the second vertices

The first shape will move to align

Added ability to ‘Orient STEP items
In the STEP Preview, with Orient mode selected from the Tools menu, you can select any two faces
of any 3D Items (including two of the same item), and the first face, along with the attached shape,
will rotate around to face in the same direction as the second face.
This will move the STEP model (along with the Component), into a new position chosen. This
positional change will be reflected in the PCB design with a reposition of the Component.

Select the first vertices or face

Select the second vertices, the edge
of the capacitor in this example

The first shape will rotate to match
the capacitor

View and Alignment options added to ‘Position STEP Model’ dialog
View orientation and Tools options have been added to Position STEP Model dialog on the Tools
menu when editing a Footprint.
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The drop-down View menu enables you to select one of the preset views available. These are the
same as the views available on the existing 3D View Orientations toolbar.

The drop-down Tools menu will enable you to interactively position and align your STEP model with
the footprint. Options for Align, Orient and Rotate are available. These are same as described above
for the main STEP Preview window.
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Design Units now used
Another change on this dialog is that all units shown will now be current design units and not forced
to mm (Metric) as they were previously.

Import Mounting Holes and Vias into design from STEP Model
The Import STEP Board dialog, available from the File menu and Import Design Data on a STEP
file) has been extended to provide additional fields to provide max sizes of Mounting Holes and Vias
seen in the STEP model being imported to the design data. When a circle is discovered that is smaller
than the specified mounting hole diameter, the circular element will be removed from the shape and a
mounting hole will be created in its place, or a via if it is small enough for that. It assumes that
mounting holes are bigger than via holes so it does the tests that way round.

Import STEP Board Placement Sites
The Import STEP Board dialog, available from the File menu and Import Design Data on a STEP
file) has been extended to provide additional options to allow the location of items in the STEP data
to be turned into Placement Site attribute positions in the design. These will only be added if they
are inside a board outline in the design. The STEP files have an object location catalog for the topmost elements, components like connectors, switches and other objects that the mechanical
department preplaces on the board for placemen of those objects.
Additional controls allow you to choose the Attribute Name to use, the Text Style, and the Top and
Bottom Layers for the attribute positions that are added to mark placement sites. The Top layer is
used for STEP file locations where Z >= 0, and the Bottom layer for Z < 0.
Choose from the Attribute Names listed in the drop-down list, or enter a new attribute name.
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You can also use the Only Within Board check box to choose whether or not to keep any positions
that are outside all board outlines.

3D Package Viewer Retirement
The old 3D package viewer (not associated with viewing STEP models) is no longer available on the
menu. This has been retired and removed along with Packages feature from the Library Manager
and 3D Settings options from the Setup menu. If you wish to continue using this feature, you can add
it to your menus using the Customise option or use the Run Command option or assign the
command to a shortcut key.

Line Select Mode
With nothing selected in the design, right click and the new Line Select selection mechanism will be
available, if something is already selected it will be on the Select sub folder. Use this to define a
straight line to select only items that cross that line.
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Once selected from the menu, draw the line across the items you wish to select.

The selection will then be made:

Like Frame Select, keep the Ctrl key pressed down to alter the selection. Use the Shift key to extend
the selection to whole items.
Line Select is also available from the context menu in Align mode and Latched operations such as
Move when nothing is initially selected.

Changes to Frame Select and Polygon Select Modes
Both Frame Select and Polygon Select modes will now act on individual track segments to make
segment picking more versatile. This will operate with the option in Options, Select page, Select if
Completely Framed is set to on or off.

Changes to Double Click to Edit Mitre
Double click on a mitre has been changed so that it will enter the Edit Mitre mode regardless of its
mitre size. The Edit Mitre mode is also available on the context menu for a selected mitre.
For adjusting multiple mitred corners, such as parallel tracking, this change works in conjunction with
the three selection modes described above (Line, Frame and Polygon).
In Version 10.5, it was changed to work on double-click if it was less than twice the default mitre size
as defined in the Options dialog and Edit Track option. This change has been reversed in Version 11.
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Insert PCB Track more responsive
Snapping to a line orthogonal with the target (item at end of connection, or point between the two
connections if a Differential Pair) is now responsive and easier to snap to, retaining the pad centre to
the orthogonal track.
You can now also avoid snapping to the Pad centre by holding the down the Shift key whilst moving
the track.
This feature was back-fitted to 10.5

Restricted Movement Segment Mode – Snap To Angle Step
When editing a Track or shape in Restricted Movement Segment mode and the restricted angle is
not zero, you can now change how the angle is snapped to.
Once routing in Restricted Movement Segment mode, from the Segment Mode context menu, there
is a new option Snap To Angle Step.
This option will only appear if the Snap Angle is a multiple of the restricted movement angle.
Unselect this option to snap to any 45-degree step relative to the restricted movement angle (as it
worked previously). Using this new mode, you can snap to any multiple of 30 degrees. Previously, it
would only snap to the angle entered and any 45-degree step from that angle (30, 75, 120 ...).

This feature was back-fitted to 10.5.

Select Track Paths by selecting Components
In Select Mode, if 2 or more components are selected, if you right click, the context menu displays
Select Track Path. Selecting this, the current selection will be deselected and all track paths directly
between the previously selected components will be selected.
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Copy/Paste into new Shape Type
You can now Copy and Paste a single track as a generic Doc Shape. This feature can be accessed
when using Insert Doc Shape and then using Paste before starting to draw a shape. The selected, and
copied track shape will be pasted in as a doc shape.

Layer Control Added To Change Shape Type
You can now change the Layer in the Change Shape Type dialog using the Layers drop down list
box. Previously, a Layer change was only possible using a different option or dialog
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Pad Auto Necking
A new rule page has been added to Technology DFM/DFT rules called Pad Track Neck. This
specifically for Pad necking into and out of pads.
This rule allows you to define a Pad Track Percentage which is the percent that the necked track
width will be in comparison to the pad width (for example, if the pad width is 50 and the percentage
is 80% then the necked tracks width will be 40).

The Min Length option defines the length of the necked segment. This length is measured from the
edge of the pad to the tip of the ‘fat‘ track. The completion shape also takes this new calculation of
the length into account when creating a necked completion shape.
The Global Pad Track Neck Rules at the bottom section includes the option to Always Create Style
With Correct Width. With this option disabled, when the necked track is created and if the style is
not already in the design, a message will display asking if you want to add the style. If the option is
enabled, then the style will be added without warning.
For this rule to be operative, you must have the option from the Options dialog, Edit Track page and
Auto Neck enabled. It can also be enabled in the editing options section of the context menu when
editing a PCB track.

When operating, it will look like this when you click to make a corner:
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If the check box to Always Create Style With Correct Width is enabled and a new Track Style
needs to be added, a warning dialog is presented:

The new Track Style will be created at the percentage width to that of the pad it is exiting.

Auto Necking
You can now neck to and from pads or through gaps that would normally cause a DRC error. It can
be used when routing anywhere in the design and will neck down the current segment to avoid DRC
errors. Once avoided, it then reverts to the regular style after passing the items that would cause the
error, you can then continue routing.
This mode can be used by either clicking directly on the pad or using the completion shape. When
using the completion shape for pad auto necking, it will show the necked segment at the end of the
completion shape.
You can enable this option from the Options dialog, Edit Track and by selecting Auto Neck. It can
also be enabled in the editing options section of the context menu when editing a PCB track.

When editing a track near a pad a potential violation takes place, the necking will be performed:
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Add Item to Net in Net Properties Dialog for Copper and Templates
You can now use Properties to add an item to a net, for example a Copper shape or Template.

An item not on a net will show as <No Net>. Changing this to a net name will add it to the selected
net. Clearing the net name will add it to a default net, but it will ask you first.
If multiple items are on different nets it will now show as <Different> (whereas, it used to be blank).
By typing a single net name will merge the nets to one net (after asking about merge).
If multiple nets or multiple no nets, and the net name is cleared, after asking if you want default net
names, you will be asked if you want to merge all nets into one default net, or to create multiple nets.
(Note: In Schematics, you will not be asked and individual default nets will always be created).

Add Copper & Template Shapes to Net on Insert
Whilst adding Copper or Template shapes to your design, you can now add them to a net using the
Add To Net option from the context menu option.

This can be done either before you start the first point, or whilst adding the shape. If you have a
similar item preselected the net will be taken from it (previously, this worked for templates), but it has
been changed so that if you preselect a different type of item (a track for example) the net will be
taken from that item and a warning will be issued to ask if you want to use that net.
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If whilst adding the shape you wish to change the net name or remove it from the net, use the Change
Net option from the context menu and edit the name or remove it in the dialog.

This feature was back-fitted to 10.5.

Non-Connecting Copper Highlight Colour
A new category for Non-Connecting Copper has been added in PCB Colours under Highlights.
The Non Connecting switch on Technology, Copper Pour Rules and Copper Shape Properties,
causes isolated copper areas to be marked as Non Connecting. This means that it can remain isolated
and does not form part of the connectivity, although it does still retain the same net name. You may
require this to maximise copper on the board.

Reversed View Status Saved
When Reversed View is enabled in your design, this status is now saved when Save or Save As are
used, this means the design will remain reversed when re-opened.
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Attributes on Wires
You can now add attributes to Wires in the design using Properties or Add Attribute. These can be
used to hold copper wire material or the wire diameter for example.

These attributes can then be used in the Find bar to select all wires of the same diameter for example.
You can also use the Report Maker option to report wire links and their attributes in a bill of
materials, along with the standard Wire attributes that already exist (such as Length and Insulated
status).
This feature was back-fitted to 10.5

Layers Bar – Components Filter
From within the Filter section of the Layers Bar, you can now toggle the Show and Pick status of
Components:
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Toggle Layers Changes
Alias Assignments
Layer Toggle commands can now have an Alias name assigned; this allows for more
readable/shorthand descriptions of the command. These names can be defined in the Layer Toggle
Setup dialog.

Layer Toggle Alisa names can be viewed in the new Toggle Layer Bar (see below).

New Toggle Layers Bar
A new dockable Toggle Layers Bar has been added. This allows you to activate any of your defined
layer toggles on the fly, while in design.

The Setup button will take you to the Setup Toggle Layers dialog from where you can define the
Toggle Layers.
If you right click on the Toggle Layers Bar, a context menu is available:
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Three active settings enable you to display additional information if defined in the Toggle Layers
dialog on the Toggle Layers Bar: View Toggle Numbers, View Toggle Aliases and View Toggle
Shortcuts. The Set Toggle Layers switch will take you to where these can be defined.

New Toggle Plane Command
A new command has been added to toggle the display of Powerplanes on and off.
If you have a plane layer called Ground then you would create a toggle plane ground, this will
toggle the Powerplane display state of that layer in the same way that you get when clicking on the
little thermal icon on the layer in the Layers Bar.

Measure Bar showing Spacing Rule
The Measure Bar now displays the rule that corresponds to the calculated spacing.

Error Bar - Tooltip available on Error Rule
When an error marker is displayed in the Errors Bar, the rule violated can be displayed in a tooltip
by hovering the mouse over the marker. This is available when the full error name cannot be
displayed.
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Placement Vector - Include Power/Ground Net
New check boxes in Options and Move allows you to select whether Power and/or Ground Nets are
to be included in the calculation of the most optimal point for Component placement using the
placement Force Vector. Power and Ground nets are defined by their Net Type (Power or Ground).

Unchecking either of these boxes will change the dynamics of the force Vector. Unless you
specifically require these nets to be included on the calculation, we suggest you deselect these.

Keep Existing Rotation in Swap Component Positions
In the Utilities menu, Swap Component Positions tool, there is a new feature on the context menu
available during use of this option. You can now Keep Existing Rotation if enabled, this will allow
swapped components to keep their original rotations but still have their positions changed. If disabled,
swap component positions will be completed as before (rotations will be changed to match swapped
component).
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Spread-Out Option Changes
The Spread Out utility, available from the Utilities menu, now has a companion Spread Out
Manually dialog, which is accessible from the context menu. This allows for more specific changes
to the dimensions and spread distance, plus refinements to spread parameters.

Auto Insert Testpoints – Include Unreachable Testpoints
From the Tools menu and Auto Insert Testpoints dialog, there is now an option to include
previously placed unreachable testpoints.
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Excluding these would mean that previously placed testpoints, which are unreachable according to the
current rules, would not be included in the count, so additional testpoints would be required.

Create Breakout Pattern (BGA Fanout) in PCB
Within the PCB design, there is now a command available in the Tools menu called Create
Breakout Pattern. This is used to create breakout (fanout) patterns within the design without the
need to create a Breakout pattern in the footprint first. To use the option, select a component or a pad
on the component and use the Create Breakout Pattern option on the context menu. A dialog is
displayed from which to choose the pattern required:

The dialog will only create a pattern for components that have at least one pad that is on a net and
does not already have a routed connection. Applying a pattern will not delete or edit any existing
tracks that are attached to pads on the component (no changes will be made to these pads).
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When applying a pattern, a DRC check will be performed. Selecting No will remove the inserted
pattern.
The command for this option has changed from Create footprint breakout pattern to Create
breakout pattern. You will need to reassign this if you have already assigned it to a shortcut key.
Another small change is that you are no longer able to use this option if the selected component in
your PCB design already has breakouts.

CAM Plot Changes
Multi-Threading of Gerber Plots
Gerber Plots can now be completed using multiple threads (including Gerber verification plots)
when running CAM Plots.
The selection to Enable Threads for CAM Plots Gerber export has been added to the Options
dialog, General page. This setting is used by all Multi-threading technology in Pulsonix.

Excellon Setup Min Drill Diameter
In the CAM Plot dialog, Excellon Setup page, there is a new setting to define the Min Tool
Diameter.
This is very useful for the output of Pad Slots that have special or intricate shapes. This option
defines the smallest valid tool diameter that will be used for these shapes. These would be shapes that
are not regular slots that can be milled using a standard drill. When used to route custom shapes, no
attempt is made to shrink these shapes so the drill should be as small as possible and in accordance
with what your manufacturer can mill.
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Optional Formatting information for Excellon output
In the CAM Plot dialog, Excellon Setup page, you can include optional formatting information at the
start of the Excellon file.

Include FILE_FORMAT comments includes some comments, at the start of the file, of the form
;FILE_FORMAT=2:5 (where 2:5 is the integer:decimal places format), ,INC is you are using
incremental, and ,LZ is you are using leading zeros. You also get a comment of the form
;TYPE=PLATED or ;TYPE=UNPLATED when appropriate.
Include Format after Units includes, LZ (for leading zeros) or TZ (for trailing zeros) followed by
the number format shown as 00.00000 for 2.5 (e.g. METRIC,LZ,00.00000). This is only relevant if
you are using leading or trailing zeros.

Output file names template – Use Default button
A new button, Use Default, has been added to the Output File Names Template section of the Plot
Settings tab in the CAM Plot dialog. This returns the template to its default value which is:
$(DesignName)$(PRE)-$(Variant)$(PRE)($(PlotName))$(POST)
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Output to SVG Device
Using the Output menu and CAM Plot dialog, you can now output an SVG file. The SVG file will
be an image of the design using the standard rules selected for content and scale. This is available for
both Schematic and PCB designs.
The SVG output is available on the list of ‘devices’ on the drop-down list:

The CAM Plots grid shows SVG as the Device name:
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Output to ZIP File
You can now pack all the generated output files (from the CAM Plot option) into a ZIP file.
From the CAM Plots dialog, on the Plot Settings page, there are three new check boxes:

Check Pack output files into a ZIP to create a ZIP of all the generated output files in the folder
specified in the Folder for output files section.
Check Remove individual files after ZIP to delete all the individual output files created, leaving you
with the ZIP file only.
In the Plot Report section, check Include in ZIP under the Plot Report section to also add the CAM
Plot report to the ZIP file.

Panel Editor – Reset Layout Command
When in the Panel Editor, there is a new command Reset Layout... This is available on the context
menu dialog and is used to re-apply Panel Gap/Spacing between PCBs.
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Track Impedance Calculator
Differential Pair (CPWG) impedance calculations have been added to the Design Calculators, the
CPW and CPWG options also allow for calculation of the conductor space.
Coplanar Waveguide

Coplanar Waveguide with Ground

Edge Coupled Coplanar Waveguide with ground

Design Calculators – Values taken from design
The Design Calculator dialogs will now take more parameters from the selected track or via. The
dialogs will indicate which values have come from the design by using bold text.
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New Material Parameters
New parameters for Electrical Conductivity and Dielectric Constant defined in the Materials
dialog are used by calculators.
Also added is the ability to specify a Material for special use Hole Plating and Micro-Via Hole
Plating. This is selected in the Materials dialog:

Track Impedance Calculator – Calculating Impedance
Track Geometry
In on-the-fly mode, you can use the context menu to choose the Geometry to use, or choose Auto
Detect Track Geometry to try and choose the correct geometry for the track that has been picked (by
looking at layers stack and if it is buried in a plane).
The Differential Pair check box will be checked (or not) depending on if the picked track is a paired
track.
Relative Permittivity
Will be taken from the Dielectric Constant value on the Material used by the dielectric layer above
or below the layer of the picked track (if it is defined).
Dielectric Thickness and Track To Plane Gap
These will be taken from the thickness of the dielectric layer above and below the layer of the
picked track (if it is defined).
Track Spacing
When picking a Differential Paired track, the Differential Pair Gap will be used for the track
spacing.
Conductor Space
When picking a track, the Track to Copper Spacing for that track and at that point will be used for
the conductor space for Coplanar Waveguide calculations.
Track Thickness
Will be taken from the thickness of the layer of the picked track (if it is defined).
Track Impedance Calculator – Calculating Track Width
Differential Pairs
The Impedance value provided as an input will be the Differential Impedance when calculating the
required track width for a Differential Pair. The last field in the result will be the Characteristic
Impedance.
Take Impedance Values from design
The Characteristic Impedance will be taken from the Track Impedance Rules for the net of the
picked track, or to get the Differential Impedance from a Differential Pair (or one of the nets if not on
the pair),
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Track Width & Resistance Calculator
Copper Resistivity
This will be calculated from the Electrical Conductivity value on the Material used by the layer of
the picked track (if it is defined).
Via Resistance Calculator
Via Depth
This will be calculated from the thickness of the layers that the via passes through (if they are
defined).
Plating Thickness
This will be taken from the thickness of the Material that has special use Hole Plating or Micro-Via
Hole Plating, dependent on the type of via selected. (if it is defined).
Resistivity
This will be calculated from the Electrical Conductivity value on the Material that has special use
Hole Plating or Micro-Via Hole Plating, dependent on the type of via selected. (if it is defined).

Interactive High Speed Option – New Rules & Changes
Back Drilling
The Back Drilling functionality is a feature of the Pulsonix Interactive High Speed option, it is
only available with this license.
Back Drilling, is a process used to remove the unused stub of drill holes from a through-hole when
creation high-speed PCBs. This technique ensures signal stubs are minimised (which can be a source
of impedance discontinuities and signal reflections). With increased data rates this aids the reduction
of signal distortion. This is alternative method to using blind and buried vias which are costly to
manufacture.
The process of Back Drilling
In order to utilise Back Drilling, the summary below informs you of the general process:
-

Identify a requirement for it, then:

-

Add Back Drill Spans to accommodate Back Drilling in your Technology

-

Create Back Drilling Rules in your Technology

-

Route your design, vias and spans that match the Back Drilling rules will be created

-

Export the Back Drilled Vias to the Excellon NC Drilling format using the CAM Plot option You
can also export a user report created using the Report Maker.

In addition to the above, new features have also been added for Design Rules Checking, exporting to
various other formats such as IPC-2581, GenCAD, ODB++ etc. and user defined reports using the
new commands within the Report Maker.
Technology Back Drilling Spans
A Back Drill Span page has been added to the Technology under Layers. These spans define the
layers of a via that need to be Back Drilled. The start layer of the span is either Top side or Bottom
side, and the end layer will always be an inner layer. All layer spans have to have unique name; a
Layer Span cannot have the same name as a Back Drill Span.
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The Back Drill Depth is the depth of the oversized drill hole after Back Drilling. This value takes
into account the Back Drill Stub Length (taken from the Back Drill Rules page), and is measured
from the top or bottom of the board to the inner electrical 'Stop' layer of the Back Drill span (this does
not include the thickness of the stop layer). It is calculated from the layer thicknesses, or can be
specified as an explicit value by unchecking this option and typing the value required. If you have
specified layers thicknesses, you are likely to want to use these.
If the Use layer thickness box is unchecked, you can define your own thickness for the span. When
the drill depth is <undefined>, the calculated drill depth is less than zero. The most likely cause of
this is when the defined Back Drill Stub Length being too large.
The View Layers button will display a cross sectional view of the layer stack the same as the Layers
dialog.
Auto Generating Back Drilling Spans
The Auto Gen button on this page enables you to automatically generate a list of Back Drill spans
that are usable by your current design. These will be generated from the rules defined in the Back
Drill Rules. The grid is filled with Back Drill spans that can be used in the design.

The check box for whether you Include then or not include them enables Back Drill Spans rules used
to be overridden if not required.
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Technology Back Drilling Rules
The Back Drill Span rules page in the Technology Layers dialog allows you to define the nets that
will be Back Drilled (or not if excluded from the list). A net will match with the first relevant rule in
the list, so the order of the rules is important. As with all rules, wildcard matches are permitted.

Use the Include check box options to select the Vias, Component Pads or Mounting Holes that will
be Back Drilled. The Vias check box is always selected but Components and Mounting Holes can be
optionally added if required.
The Global Back Drill Rules at the bottom of the dialog let you define a Drill Oversize for the
larger drill used for all Back Drilling in the design.
Drill Oversize will be the increase in the drill radius compared to the vias’ defined Drill Size, or as a
Percentage increase in radius compared to the vias’ drill size.
You also define the remaining Stub Length required after Back Drilling has been performed. This is
your safety margin to absolutely ensure the via stop pad required isn’t drilled out.
The sizes and values for Drill Oversize and Stub Length will be supplied by your board
manufacturer, it is important to define these very carefully to avoid errors.
Identifying Back Drilled Vias in your Design
Back Drilled vias have a circle drawn around them (with the same diameter as the oversized drill) and
a curved line going through the pad.
The colour of the circle is dependent on whether it is a Top Back Drill (same colour as Top layer) or a
Bottom Back Drill (same colour as Bottom layer), with the curved line being the same colour as the
Stop layer of the Back Drill. The curved line will be horizontal for a Top Back Drill and vertical for a
Bottom Back Drill. If the via has both a Top and Bottom Back Drill span, then both shapes are drawn
together.
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Top Back Drill

Bottom Back Drill

Both Top and Bottom Back Drill

Back Drill Colours
The colours for the three Back Drill types can be set using a new tab in PCB Colours, called Back
Drill Spans and by selecting the relevant Back Drill Span in the list.

Update Back Drills
A new feature named Update Back Drills has been added to the Utilities menu. Use this option to
check and assign the most appropriate Back Drill spans to the vias that are on Back Drilled nets and
that currently don’t have this status.
This option is also automatically run when the CAM Plot option is initially run.
Back Drilled vias can be checked for using new checks in the DRC option, see below.
Back Drill Spacings
Back Drills are taken into account when doing both Design Rules Checking and Online DRC.
A new Drill spacing has been added to the Design Level Spacing Rules on the Drill tab called Back
Drill to Copper Items. This is the spacing between Back Drills and other items such as Pads, Vias,
Copper etc.
The ‘general’ Drill to Drill spacing handles Back Drill to Back Drill spacing, and Drill to Board
handles Back Drills to Board spacing.
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Back Drilling DRC
The Design Rules Check dialog now has a Back Drill check box in the Spacing section.
This checks the spacing between Back Drills and other items using the Back Drill To Copper Items
spacing defined in your Technology. Back Drill to Board and Back Drill to Drill is checked in the
Drills Spacing.

A new check has been added to the DRC under the Manufacturing section called Incorrect Back
Drills. This check will report an error if a Via Back Drill span is currently incorrect (checked against
the Back Drill Rules) and requires updating using the Update Back Drills option.

Running this will also check if there are any Back Drill spans that have a negative drill depth. This
happens when the Global Back Drill Stub Length is greater than the depth of the span itself (as
defined in the Back Drill Rules page).
Via & Component Pad Properties
The Via & Component Pad Properties dialogs now has a Back Drill tab which shows the used
Back Drill spans. Checking and unchecking the option allows you to enable or disable Back Drilling
for that specific via. The Back Drill spans cannot be changed inside Via/Pad Properties.

Back Drilling Pin Depth Attribute for Component Pads
A new attribute on a Component pin called Pin Depth has been added. This allows you to define the
depth of an individual pin so that you will know the maximum depth allowed for Back Drilling.
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A new attribute has been added called Part Pin Depths that allows you to define all the pin depths
for that specific Component. This means by setting this attribute on a Part, it will not need to be set on
every pin of the footprint. This will override any value assigned using the Pin Depth attribute.
If a Back Drill rule defined includes Component Pads, neither of these attributes are used.
Layer Span Layers automatically included in Layer Stack Preview
The From Layer or To Layer of a Layer Span, or the Stop Layer of a Back Drill span is now
included in the layer stack preview. For the applicable layer where these are used, the In Layer
Stack Preview check box on the Technology Layers page will be checked and disabled (greyed out).

Inserted Layer Stack Previews
Both the Layer Stack Preview inserted into the design and the View Layers option (in Technology,
Layers, Layer Spans and Back Drill Spans) now show Back Drills.
In the Technology, the View Layers button works the same on the Layers and Layer Spans pages
(shows layers and regular layer spans) but on the Back Drill span page, it will show the layers along
with the Back Drill spans, no regular layer spans are shown.
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On the Insert Layer Stack Preview dialog, there is now an Include In Preview option. This defines
which spans are included in the preview – All spans, No Back Drill spans, or Only Back Drill
spans.

This can also be changed later by changing the newly added include option in Symbol Properties for
the selected layer stack preview.

When changing the text box fill colour of a Callout on a Layer Stack Preview, the outline of the
span will also be in the selected colour – this was changed to compliment the Back Drill span shape in
layer stack preview.
CAM Plot Wizard
In the CAM Plot Wizard, you can now select Back Drill spans as a process, allowing for the
creation of drill files and drill drawings.
The insert drill table dialog now allows for Back Drill span drill tables. For values to be correct the
Back Drill span must be used by a via, and a drill oversize must be defined.
Pad Exceptions for Back Drilling
When creating a pad exception, Back Drill Top and Back Drill Bottom Exception Types can be used.
This allows for a pad exception to be added on a via that will be Back Drilled, on layer top or bottom
depending on the exception type.
The Exception Type allows you to select Back Drill Top or Bottom from the list:
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Excellon Report Chanegs
The Back Drill depth and Back Drill side are both output in the Excellon report. The drill output will
always be unplated.
Excellon Drill Output
Output File: C:\Designs\ExcellonPlots\Job66(Excellon).drl
Plot Name:
Variant:
Contains:
Side:
Drill Depth:

Excellon
<Master Design>
Bottom >Inner 2 BD
Bottom
0.0500

Drill Type:
Scale:
Mirrored:
Rotated:
Offset:
Step & Repeat:

Unplated
1.000
No
No
-41.9040
Not used

Unplated

-65.1905mm

IPC-2581 and ODB++ Exports include Back Drills
Back Drills are now included in IPC-2581 and ODB++ exports. No extra selection is required, this is
automatically done for you.
Back Drilling Commands in the Report Maker
New commands have been added so that Back Drilled Vias can be reported and/or added as a user
report to the design to display manufacturing information about them.
For more detailed information, see section below Report Maker Changes.
Find Bar
You can use the Find Bar to locate any vias that currently have a Back Drill span. When searching
for vias, check the Layer Span box at the bottom of the bar, and select a Back Drill span from the
drop down list.
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Track Impedance Rules
A new rule in the Technology under High Speed rules, Track Impedance, enables you to assign
Single-Ended Track Impedance and/or Differential Track Impedance (also called Edge-Coupled
Impedance) to nets or Differential Pairs on defined layers, and optionally within named areas. The
Design Calculator will search the rules for the impedance for a selected track.
These rules will be set up when Importing an IPC2581 Layer Stack and used by the Design
Calculators and Track Impedance Calculator (when calculating Track Width).
When using this dialog, the Attribute selection is made using the drop-down list where a net or
attribute can be defined, this also include <Differential Pair Names>.

Pulsonix Version 11.0 Update Notes 113

Remove Serpentine Controls Option
You can now remove the controls on a selected Serpentine track using the Remove Serpentine
Controls option from the context menu. This reverts it to a normal track that can be edited in the
usual way. Once this is done, it cannot be converted back to a controlled Serpentine (although Reduce
and Remove Serpentine routing commands may still work as Pulsonix recognises serpentine
patterns).

Rules Spreadsheet Multi-threading
The Rules Spreadsheet can now be filled using multiple threads when not using the Only show
selected or Dynamic item options. This will speed up filling for designs with large nets or where the
design contains many nets.
The selection to Enable Threads for the Rules Spreadsheet has been added to the Options dialog,
General page. This setting is used by all Multi-threading technology in Pulsonix.

Create Differential Pairs From Rules
You can now create Differential Pairs in a Schematic or PCB design by setting up and then applying
new Differential Pair Nets rules, defined in the High Speed Rules section of the Technology dialog.
This enables you to create a rule or rules that capture the net names in your design to apply to nets
that should become Differential Pairs without having to do this process manually.
Each rule defines a pair of net match strings that are used to find two nets that match the strings where
the common part of the name is the same.
The Attribute value, Net Name for example, will be the Match criteria. You can set this to a specific
match, such as SDQ0* or can be more generic, such as * for the whole name.
Once the attribute Match has been satisfied, the rule then uses the Differential Pair Nets rule to make
the pairing. For example, rule *_P and *_N will match nets SDQ0_P and SDQ0_N. When two nets
are matched, the rule defines what name the Differential Pair will take, whether an attribute should be
added to use when allocating length rules, and some default parameters for the pair.
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Attribute
A rule defines two sets of nets. Each set is defined using a net Attribute Name and a Match value.
The Match Value can be wildcard. In particular, you can match the inbuilt attributes Net Class Name
or Net Name. When these checks are done, each rule is applied, so the order of these rules is
important.
Match
The Match value, Net Name for example, will be the Match criteria use for the rule. You can set this
to a specific match, such as SDQ0* or can be more generic, such as *. Only nets matching this value
will be considered for a Differential Pair.
Differential Pair Nets
Once the Attribute Match has been satisfied, the rule then uses the Differential Pair Nets rule to
make the pairing. For example, rule *_P and *_N will match nets SDQ0_P and SDQ0_N. When two
nets are matched, the rule defines what name the Differential Pair will take, whether an attribute
should be added to use when allocating length rules, and additional default parameters for the pair.
The Net 1 Match
This is used to match the net defining one 'half' of the Differential Pair net. It is matched along with
the Attribute Name. The Match Value can be a wildcarded string. For example, if the Attribute name
matches SDQ0, the net 1 match might be *_P so will match SDQ0_P.
The Net 2 Match
This is used to match the net defining the second 'half' of the Differential Pair net. It is also matched
along with the Attribute Name. The Match Value can be a wildcarded string. For example, if the
Attribute name matches nets SDQ0*, the net 2 match might be *_N so will match SDQ0_N.
Match Within (for a PCB design)
You can also choose to only match nets if they have pads within a certain area. The Item Type will
show Area or <None> when used within a PCB design. The Name Match can be an area name
selected from the drop-down list or it can be left blank so the rule is applied to the whole design. The
Match Value can be wildcarded.
Differential Pair Name
This box shows you how the Differential Pair Name will be constructed if you let the system create
one for you. This will be based on the Field and Match Separator fields below. This is an editable box
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and can be constructed from the Fields selected form the drop-down list. At any point, you can also
use the Delete key on your keyboard to removed fields if not required.
The Field drop-down has a list of possible contents from which to create the Differential Pair Name.
Possible contents available are:
Common part of the net names - use this to name the Differential Pair with the common
part of the two net names. If the Attribute Match string contains a stem before the wildcard *
you can choose a separator to be used after that stem in the resultant name. If this is required,
type the Match Separator or select it from the drop-down list. For example, if the Attribute
Match string is SDQ* and *_P and *_N are used to match nets SDQ0_P and SDQ0_N, then
the common part of the names will be SDQ0, and if the Match Separator is "_" it inserted
after the stem to give a Differential Pair name of SDQ_0.
First net name
Second Net Name
Net Attribute - select the net attribute name from the list presented. The value will be
extracted from the first net used to define the Differential Pair.
Component Attribute - select the component attribute name from the list presented. The
value will be extracted from the first of the pins used to define the Differential Pair.
The Insert button takes the Field (and Match Separator if selected) and passes them into the
Differential Pair Name to show you how it will be constructed in the rule when used. Multiple fields
can be selected from the list and inserted. The insertion will depend on your cursor position in the
Name field above.
Add Differential Pair Attribute
Use this to define an attribute to be added to the newly created Differential Pairs using this rule. For
example, to assign an attribute to be used to allocate a Differential Pair Gap or Skew rule. Leave the
fields blank if no attribute is to be added.
If required, select the General Use or Net Attribute Name from the drop-down list, and type the
Value to be added. If some design items already have attributes using this attribute name their values
can be selected from the Value drop-down list.
New Differential Pair Values
You can define how the tracks are paired. Edge Coupled are the usual Differential Pairs, the edges of
the two tracks separated by the specified gap. Broadside are paired vertically, the tracks laid on top
of each other on different layers. It is possible to allow both types of pairing on a Differential Pair.
Allow Track Spurs
Normally, the path between the pins in a Differential Pair should be without any spurs or branches to
other pads, vias, etc. Checking the Allow Track Spurs option will allow spurs from the track path.
These spurs must not have any further spurs or branches and should be terminated on a pad, via or
testpoint. These will be checked as part of the Differential Pair Design Rule Check and in the
Differential Pair report.
Include All
Normally pins are not included in the path between the pins at the ends of the Differential Pair, but
sometimes this is required. Checking the Include All box will instruct Optimise Nets to connect to
any extra pins on the net that are in this path and not assigned to other Differential Pairs, allowing you
to route them into the path without a Differential Pair error.
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Match Within Schematic
If setting the Match Within value from a Schematic, the drop-down list will also display additional
settings for Block and Block Instance.
In this case, Block Instance Name is the name of an instance of a block in the design. Block Name is
the name of a block used by the instance; several block instances may use the same named block. The
nets may be across the design but the reason for the area is only pins defined in that area, block, or
block instance will be considered when creating the Differential Pairs.

Create Pairs From Rules Dialog
When the rules have been set up, use the new Create Pairs From Rules button on the Technology,
Differential Pairs page. You will be presented with a dialog that informs you which new pairs will
be added and which existing pairs will be renamed or have an attribute added due to the rules. Here
you can choose to not add or rename a Differential Pair by unchecking it in the list, or can type their
own name for the pair.
The New Chain dialog will not create a Differential Pair if the nets do not have enough nodes.

In the Technology dialog, if you select an existing Differential Pair Name or add a new one and it
matches a rule that would give a different name or would add an attribute, a button will appear next to
the Name field to use to apply the rule. This will change its name and/or add an attribute.
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The dialog is split into two sections; Differential Pairs that will be created and Differential Pairs that
already exist, but will be renamed or have an attribute added or changed.
Differential Pairs that will be created
The number next to this header informs you of the number of potential new Differential Pairs that will
be added to your design if all the rules available are applied. The main list is a summary of all the
Differential Pair names and their paired nets. By default, the Create check box next to each name will
be selected (so that all new Differential Pair Names required will be added). If the new name is blank
then the name will be the default name generated from the four p ins names. Uncheck this box if you
do not wish to create a new pair in your design. If you do this, care should be taken to ensure you
haven't missed a pair that you defined in the rules.
This list is applied when the OK button is pressed at the bottom of the dialog.
Differential Pair that already exist
This reports any matches between the rules defined and the Differential Paired nets already in the
design. The number displayed next to the header is a match based on the rules defined. Using the
Rename check boxes, you can select which existing differential Pairs to rename. Again, care should
be observed if you uncheck any of these as it means they match rules defined but you are choosing to
ignore them.
This list is applied when the OK button is pressed at the bottom of the dialog.
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Summary boxes
Three summary boxes at the bottom of the dialog report an overall position to you based on the check
boxes selected in the grids above, any rules that it fails to match based on the Differential Pair Rules
defined and a count of the number of rules that were not matched.
Number of Differential Pairs already created that match the rules, shows the number of
Differential Pairs which match your defined rules and that exist in your design. This is shown as a
reference for you.
Number of Differential Pairs already created that do not match the rules, shows how many
Differential Pairs that are currently in your design that do not match any rules. This is a very useful
check to ensure that if you do want to cover all Differential Pairs using rules, then this should read
zero. If the number 1 or more is shown then there are Pairs that are not covered using a rule.
The Number of rules that were not matched shows that Differential Pairs rules have been created
but there are no matches in the design to satisfy this.
Use the Report button to report listing the Differential Pairs that already matched, did not match at
all, and the rules that were not matched (with an explanation of why).
Reapplying Rules
A new button on the Differential Pairs Nets dialog next to the Diff Pair Name enables you to
Rename to Apply Rule to match any new rules defined in the Differential Pair Net Rules dialog.

Create Differential Pair using Context Menu
You can now select two nets in a PCB or Schematic design and from the context menu use Create
Differential Pair to create the ‘pair’. Once these nets are selected, it will open up the Differential
Pair Rules dialog in your Technology with these nets pre-selected and ready to define.
If four pads are selected, they will be used for the pair, otherwise the pads will be automatically
allocated. You will not see this command on the context menu if the nets already form a Differential
Pair, or don’t have at least two pins on each net.

Pulsonix Version 11.0 Update Notes 119

Define Differential Pair Rules using Net and Net Class Attribute
You can now define Differential Pair Gap and Skew rules with a Net or Net Class attribute. The
rule is only used on a Differential Pairs where both (paired) nets match the attribute. For example,
defined for a specific Net Class name.
Previously, it was only the Differential Pair name or Differential Pair attribute that could be used,
now you can assign a Net attribute and it will check both nets for a match.
Note: Differential Pair Skew rules defined this way will not be used on Chains (which can have
multiple nets), only on Differential Pairs.

This feature was back-fitted to 10.5
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Create Differential Pair Chain
The New Chain dialog on the Differential Pairs dialog has changed to make it easier to choose the
correct Differential Pairs for a chain.

It now features two lists; the left one contains a filtered list of Differential Pairs in the design to
choose from, and the right list contains the chosen Differential Pairs that will represent the chain.
Selecting a Differential Pair name in ether list will display its nets and pins in an information panel
below the list. You can filter the left list by attribute that can be a Differential Pair attribute, Net
attribute, Component attribute or Pin attribute. The Net attribute will have to exist on either Net
on the pair and the Component or Pin attribute will have to exist on any of the four pins in the pair.
You can also Include Pairs In Chains (or exclude by unchecking the option) all Differential Pairs
that are already in a chain from the list, this helps refine the list.
The Chain Name text box allows you to set a name for the newly created Differential Pair chain
when you exit this dialog. If this box is left blank, then a default unique chain name will be generated
for you.
The Apply button allows you to quickly create a chain and start the creation of another chain. This is
done by creating a chain using the currently input details. Checking on Apply will ensure if name is
unique, if not enough Differential Pair have been added, etc. It then then resets the dialog and updates
source list to allow you to start the creation of another Differential Pair chain without you needing to
reopen the dialog using the New Chain button again.
Once you have the Differential Pairs selected, type a new Chain Name and press OK to return to the
Differential Pairs dialog where the chain will now be presented:
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Once you have created the chain, selecting it in the grid still displays the chain controls, but the
Add… button has been replaced with an Edit… button. Selecting it displays the New Chain dialog
where you can edit the chain.
New <Component Pin Name> attribute
To make this chain easier to locate, a new pin attribute has been created <Component Pin Name>,
for example U12.6. Use this if you need to find the pair that connects to that pin. This attribute is
available throughout Pulsonix.

New ‘Start Pairing’ Mode for Differential Pairs
The ability to start routing a Differential Pairs using new Pairing Start Mode instead of using
Mirror Mode has been added.
When you start editing a Differential Pair track, the mode used will be as defined in the Options Edit
Track page.
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The choice is Single Track Mode, Mirror Mode and the new Pairing Start Mode.
Paring Start mode is fundamentally the same as using the Insert Bus Route option in that it gathers
the two tracks by single side routing to the two junctions representing the start of the paired section.
Moving the cursor moves the junction pair to the required position, and left click starts the pairing.
You can switch between the three modes using the context menu, which will show which mode you
are in.
Whilst editing, you can check what auto start mode is currently set using the Editing Options sub
menu from the context menu. The mode is shown in brackets.
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Choosing Next Diff Pair Start Mode cycles to the next mode from the one shown. This replaces the
Start Mirroring Paired Track option in 10.5.
Whilst adding paired segments, you can end pairing by selecting one of the three modes to carry on
editing. Using Pairing Start mode here allows you to automatically route the tracks around an
obstacle and start pairing again.

Differential Pair Mirror Mode
When using Mirror Mode and mirroring paired tracks (Differential Pairs), the initial segments and
the mirror line is now forced to be perpendicular to the line through the pads. Previously, the angle of
this line was based on where you clicked to start the track. This mainly effects Differential Pairs that
start on angled pads.

If you start on an angled pad, one that isn’t 45-degrees, a message is displayed informing you of this:

If you want to change the angle of the mirror line use the new Rotate Mirror Angle option from the
context menu if it is available.
If you did not intend to start mirroring this time and only want to edit the single track, switch to
Single Track Mode from the context menu.

Legal Completion Path for Differential Pairs
The Show Legal Completion Paths option now works when pairing tracks for a Differential Pair.
The path shown is as if using pairing start mode from the target pads to the junctions at the end of the
moving paired tracks. Using Complete As Track will convert these paths to tracks.
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This mode also now works when in Mirror mode.

Change Style of Differential Pairs
You can now change the style of paired Differential Pair tracks if multiple tracks are selected. The
style of both paired Tracks will be changed, along the entire paired section.
Do this by changing the style in the Change Style dialog, or in Track Properties (the style combo
box is no longer disabled).
If you select a track style that would create a DRC error, a warning dialog is displayed:

Shift to add corner in Differential Pair Mirror Mode
When using Mirror Mode and mirroring paired tracks (Differential Pairs), adding a corner when the
tracks are close together ends the mirroring mode and starts editing the pair. If you now hold the Shift
when adding the corner, you will remain in Mirror Mode. This enables you to add multiple corners to
design the track shape required before the pairing starts.

This feature was back-fitted to 10.5
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New Via Pattern option - Auto Turn
There is a new Via Pattern option available - Auto Turn. When changing layers, use this to initially
exit the vias straight, but as you move the cursor after vias are added, the pattern will change to exit
left, right or backwards to best match the cursor position. Once you corner or backspace, the Auto
Turn mode will be switched off. This is now the default action.
Select Via Pattern> and Auto Turn from the context menu:

Use copy of existing Differential Pair Via Pattern
You can now choose to use a copy of an existing Differential Pair Via pattern when changing layer
whilst adding paired tracks. You may have already created a pattern that you want to reuse, this can
be copied and reused.
Before you start Differential Pair routing you have to choose the pattern to use. To do this first select
all items in an existing pattern from the end of the paired tracks on one layer to the start of the paired
tracks on the other layer. Using Frame Select with the Select If completely Framed option enabled
will help ensure precise selection. Then, if needed, add any Ground vias that have been placed around
the pattern (used for shielding) to this selection.
In the example below, selecting the red and yellow tracks plus the vias would be suitable:

In the example below, the selection is more extended to include one segment of the Differential Pair,
this is no longer eligible for the Copy option to appear on the context menu.
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If the pattern is as required, you can then use Copy Diff completion Pair Pattern from the context
menu to save it to a special location on the clipboard.

The pattern must contain Tracks and Vias on two nets, each net selection must contain a track that
starts from a paired track on one layer, and then a continuous path from it to a track that ends on a
paired track on another layer. This path can contain several micro-vias. The pattern can change
direction and cross over.
Then, when adding new paired tracks, you can now right click to use the Via Pattern sub-menu and
choose Paste Diff Pair Via Pattern.

If the copied via pattern is suitable for this pair you will see all its vias as you move the paired tracks.
Change layer and the copied via pattern will be inserted in order for you to change layer. If the pattern
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is not suitable (wrong gap between tracks, wrong layer, etc) then change layer will not be available
until you switch the via pattern.
The via pattern option Paste Diff Pair Via Pattern will be remembered and will be used in future
whilst the pattern is available on the clipboard. Changing layer back to the start layer will use the
same pattern rotated about 180 degrees.
You cannot use Auto Turn or Drop Via with this feature. When you use change layer it is fixed to
the layer that the chosen pattern ends on.

Editing Differential Pairs into Areas
When adding Differential Paired tracks and you cross an Area boundary that has different Track
styles or Differential Pair gaps defined (in Net Styles), the pairing is automatically stopped on the
near side and started again on the far side with two transition tracks added over the border joining the
ends of the paired sections together. If it was a mistake entering the area, use the Backspace key to
remove the area transition Tracks and revert to editing the original paired tracks.

As the Differential Pair enters the named Area, it changes to the styles defined in the Net Styles
dialog.
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This feature was back-fitted to 10.5

Differential Pair Properties
For completeness the Differential Pair Properties tab when selecting a Differential Pair track, now
shows a list of Differential Pair Rules (like the Differential Pair Technology page).

Differential Pair Track Limits Display
The display for Differential Pair editing now always shows the Skew Min and Max limits as well as
the other rule min and max limits. Previously, it only showed skew limits if it was the min or max
limit, and if it was it did not show net length limits (for example).

This feature was back-fitted to 10.5
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Chip-On-Board Option Changes
The Chip-On-Board options below are only available if you have the Chip Toolkit license.

Change Chip Body Layer
With a Chip-On-Board component with bond pads selected, if you right click, there is a new option,
Change Chip Body Layer available on the context menu. Use this to move the body of the chip
down into a cavity, whilst leaving the bond pads on the top side. This avoids the need to move the
chip body and then change layer whilst moving it. This option is only available if the design has a
suitable layer to move the component to that allows normal components on it.

Change Layer of Chip Body during Move
When moving a Chip-On-Board component, using the context menu option Move Chip Body, you
can now use Change Layer from the context to move the component body into a cavity. The Bond
Pads layer is not changed.

This feature was back-fitted to 10.5
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Change Layer of Chip Bond Pads
In a PCB design for a Chip-On-Board component, with All Bond Pads selected (using the
interactive mode, Select All Bond Pads from the context menu) and interactively editable, you can
now use Change Layer from the context menu to move them to any electrical layer including layers
that are not the same as the Die/Die Pad layer.

This feature was back-fitted to 10.5

Report Maker Changes
New top-level commands for Append Report & View Report
Two new commands have been added to the top level of the Report Maker - Append Report and
View Report. Both commands can take the value Always or Never. They override the Reports
dialog settings for these values and enable you to suppress a report if you wish to run it silent or if the
report visibility isn’t required (running a format file from CAM Plots for example or within a Script).
If using the Test button, this command is ignored. It is available when running live reports.

New commands to support Back Drilling
Additional commands have been added to List of Vias and List of Pins to support the new Back
Drilling feature:
Is Back Drilled
Top Back Drill Span Name
Bottom Back Drill Span Name
Under List of Back Drill Spans, commands for Back Drill Oversize and Back Drill Stub Length
have been added. Commands supported here too; Must Cut will return the last electrical layer to be
drilled, and Must not cut will return the first electrical layer with a connection to the via after Back
Drilling has been performed. Also supported, Back Drill Span Name, Start Layer, Start Layer
Number, Stop Layer and Stop Layer Number.
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Additional commands are available when using:
On a via - Is Back Drilled, Top Back Drill Span Name, Bottom Back Drill Span Name.
On a layer - Layer Depth.
On a Layer Span - Span Depth.
New command – List of Attributes available in List of Wires
With the introduction of Attributes for Wires, you can now extract the attributes and values using
List of Attributes from within a List of Wires.

This command was back-fitted to 10.5
New command - Is Any Instance Fitted
A new command has been added Is Any Instance Fitted and can be used in a Schematic or PCB
design report. Use within a List of Variants within a List of Components. This is best used in
conjunction with the If command to test if any of the variant instances of the current Component are
fitted in the current variant.
This varies from the Is Fitted command that is available to just check if the current Component
instance is fitted in the current variant.
This command was back-fitted to 10.5
New command - Attribute In Part Library
A new command Attribute In Part Library and can be used in a Schematic or PCB design report.
Use on a Part, Component, Component Group or Associated Part to report the value of a named
attribute on the latest Part in the library (or Vault).
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This was required so that obsolete parts could be marked in the library (or Vault) and then a report
created of which parts in a design are obsolete without having to reload all the parts. If the part is
added to the design from the vault, it will get the value of the named attribute on the latest version of
the part in the vault.
This feature was back-fitted to 10.5
Define the attribute name in an attribute command using a variable
Report Maker is now able to define the Attribute name in an attribute command using a Variable.

This feature was back-fitted to 10.5.
New command - Has Track Sturs
A new command Has Track Spurs is now available to be used in a PCB report within List of
Differential Pairs, List of Differential Pair Chains and also in List of Pin Pairs when used within
the previously mentioned two lists. This reports if the pair, chain or one side of the pair or chain have
track stubs in the path from start node to end node. This can be used in a Variable to compare against
Allow Track Spurs to report an error.

Scripting Changes
Scripting changes are only outlined below. More syntactical details are available in the Online Help
under Scripting.
Folders object
The Folders object provides access to the various sets of folder information available in the
application through the Setup Folders dialog.
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This allows you to add and remove folders across all possible categories, potentially allowing a script
to be written to provide a full "change workspace" capability by programmatically resetting all
folders.
New property “DeviceString” in a CamPlot object
There is a new property DeviceString in a CamPlot object. This allows access to the printer name of
a plot.
This feature was back-fitted to 10.5
New method “ActivateDesign” in the Application object
There is a new method ActivateDesign in the Application object. This allows an already open design
to be activated (brought to the front).
This feature was back-fitted to 10.5
New Scripting Commands for Export of ODB++ and DXF
New scripting commands are available for export of ODB++ and DXF.
This is an extension to the existing command in Scripting, which previously only allowed you to
output plots for the 'normal' output devices (Gerber etc.). It now allows any 'device' that can be used
in a plot on the CAM Plot dialog; DXF, Excellon, GenCAD, Gerber, IDF, IPC-2581, LPKF, ODB++,
PDF, Reports, Pen, STEP, SVG, and Windows.
New Scripting Command for LoadTechnology
A new LoadTechnology function is now available for a Document object. Calling this function with a
full path to a technology file name will load that technology into the design. If you wish to load part
of a Technology file, you can do this now but you will have to save a partial Technology file and load
the whole file in order to achieve this.
This is a simple VBScript example of how you could use this new function:
Set Design= ActiveDocument
if Design.LoadTechnology("f:\docs\data\technology\6 Layer.ptf")
then
Message "Success"
else
Message "Failure"
end if

Call the function with a full path name to the required Technology file and it will be loaded into the
design. You can do this with a full or partial Technology. You can to use this for example to load just
CAM/Plot settings by first saving the required section out as a partial technology file. Help has been
updated to show the scope of this change.
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Changes to Import Alien Design Files and STEP Model Positions
When importing Altium designs as ASCII files, Pulsonix now reads the STEP model name, offsets
and rotations and places them into the three STEP attributes on the Footprint within Pulsonix.
Note, there have been some examples supplied that have no rational logic for model rotations and
therefore have to be manually adjusted once in Pulsonix. However, these are rare and usually only
one model in a design.

Loading Partial Colour Files
You can now load a cut-down version of the Colours file for both SCM and PCB. This should only
be done if you know what you’re doing. Further information and formatting details can be found on
the Help page under the Index heading Load Colours

New PCB Design Dialog – Set Design Units
From the File menu and New Designs tab and PCB Design, you can now choose to overwrite the
Units defined in the Technology File selected.
By selecting the Set Units check box, you can then select between Imperial and Metric, choose the
unit type and set the unit Precision.
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Changes to Default Supplied Files
Technology Files
All Schematic and PCB Technology files have been updated to reflect the new rule sets in V11.0.
Libraries
The Schematic Doc Symbol library now includes example of new Doc Symbol types for Net Label,
and Mounting Hole. Existing Doc Symbols have been redefined to give them the correct category
used for searching within the Insert Signal Reference dialog.

